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Premessa
Questo documento espone in modo più articolato quanto contenuto nelle slide relative al Terzo modulo (prima e
seconda parte) del corso AMFM ECDL GIS ed è riferito allo stato dei contenuti presenti sul sito AICA al settembre
2023 pertanto è valido se AICA non ha apportato successive variazioni :

• la documentazione sul sito AICA è presente all’indirizzo https://www.icdl.it/icdl-gis, (al momento convivono
due nomi per la certificazione GIS AICA: ECDL GIS e ICDL GIS)

• il Syllabus per il terzo modulo della certificazione è scaricabile dal link SYLLABUS in SOFTWARE USE :

• i software previsti per gli esami del 3° modulo della certificazione ECDL GIS sono:

◦ ESRI ArcGIS 9.x, ESRI ArcGIS 10.x, ESRI ArcGIS Pro (ArcGIS desktop)

◦ QGIS (NB: versione non esplicitamente indicata da AICA)

• relativamente al sw QGIS

◦ i  dati  previsti  per  i  Sample Test  e  per  lo  svolgimento degli  esami  e  i  quesiti  dei  Sample Test  sono
disponibili al link Preparati all'esame (icdl.it)  (https:/www.icdl.it/preparati-all-esame), scorrere la pagina
fino a trovare :

cliccare su GIS MODULO 3 – SAMPLE TEST QGIS si ottiene la cartella zippata con i dati previsti per i
Sample Test e per lo svolgimento degli esami e i quesiti dei Sample Test 
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◦ il sw QGIS utilizzato nei Sample Test AICA e le relative soluzioni AICA risultano riferiti alle versioni di
QGIS 1.7.4 del 2011 e di QGIS 2.2.0 del 2014  

NOTA IMPORTANTE 
AICA ha realizzato la certificazione ECDL GIS nel 2007 prevedendo per il terzo modulo i sw ArcGIS
ESRI  e  GeoMedia  Intergraph;  successivamente  è  stato  abbandonato  il  sw  GeoMedia  ed  è  stato
introdotto il sw QGIS (anno 2012) nella versione 1.7.4

Dal 2012 QGIS ha avuto molte e significative evoluzioni e si ritiene impossibile e comunque non
opportuno che i Test Center possano organizzare le prove di esame con un sw così datato e che risulta
non più reperibile.  E’ opportuno quindi che i candidati si informino presso il Test Center scelto con
quale versione saranno erogati i test.

E’ altresì auspicabile che in sede di esame vengano forniti dal Test Center chiarimenti su alcuni aspetti
dei test non compatibili con le versioni QGIS degli ultimi anni.
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Cartella per gli Esami e i Sample Test di QGIS
Decomprimendo la cartella zippata con i dati previsti per i Sample Test e per lo svolgimento degli esami e con i
quesiti dei Sample Test e le relative soluzioni  si ottiene la cartella  che
contiene:

dove:

• la cartella Dati QGIS 1.7.4 contiene:
◦ una cartella dati con i dati per gli Esami e per i Sample Test 
◦ una cartella risultati dove dovranno essere memorizzati alcune delle soluzioni richieste

• il file GIS_TestM3_QGIS_SampleTest.rtf contiene le istruzioni per gli esami e i Sample Test
• il file GRIGLIA_TestM3_QGIS_SampleTest.XLS contiene le soluzioni dei Sample Test

NOTA BENE: in sede di esame il candidato troverà configurata dal Test Center la cartella C:\ECDL con:
  - due sottocartelle C:\ECDL\dati e C:\ECDL\risultati 
  - un file .rtf del tipo test_cognome_nome.rtf contenente i quesiti e dove memorizzare le immagini risultato

Contenuto della cartella dati :

Complessivamente 95 file che definiscono: 
• 16 layer vettoriali : shapefile ogni layer è definito da 5 file (.shp .dbf .shx .prj .qpj) 
• 4 layer raster (.tif) 
• 2 world file (.tfw) 
• 3 tabelle join (.csv) 
• 1 file di progetto (.qgs) 
• 1 file di progetto temporaneo (.qgs~) 
• 2 file di stile (.qml) 
• 2 file compressi (.rar) 

Ultima data definizione file 23 aprile 2014 
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Installazione di QGIS
Per installare il software QGIS utilizzare il seguente link Scarica QGIS (https://www.qgis.org/it/site/forusers/download.html)

Scegliere la versione più stabile, al momento della scrittura di questo paragrafo la versione LTR QGIS 3.28, si ottiene
il download di un file per l’installazione:

cliccando sullo stesso inizia il processo di installazione:

proseguendo con Next :

accettare i termini della Licenza e proseguire con Next :
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dopo aver scelto di creare a fine installazione sul Desktop sia un link per il lancio di QGIS sia una link a una cartella
con i link per il lancio dei diversi applicativi installati tra cui QGIS, proseguire con Next :

scegliere Install :

A fine installazione avendo scelto entrambe le opzioni si creano sul Desktop 2 link che nel caso di esempio sono: 
• uno per attivare l'applicazione QGIS (C:\Program Files\QGIS 3.28.9\bin\qgis-ltr-bin.exe):

• uno per aprire un elenco di link per attivare i diversi applicativi inclusi nell'installazione tra cui l’applicazione
QGIS stessa:

AMFM – Corso ECDL GIS – Modulo 3 - CC BY-NC-ND 3.0 IT – (2023) pag. 9



GUI e esempi preliminari caricamento dati
GUI è l’acronimo di Graphical User Interface: interfaccia utente a volte chiamata, un po' impropriamente, schermata o
videata.

Interfaccia GUI di avvio  
L’interfaccia  utente  di  avvio  dipende  dalle  impostazione  in  essere,  da  precedenti  utilizzi  e  definizioni  fatte  e
dall’eventuale profilo utente attivo eventualmente diverso dal profilo utente predefinito.

Per un primo utilizzo dell’applicazione la GUI potrebbe essere:

ma anche:
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ancora la GUI con attivo solo il Pannello Layer potrebbe essere:

nella figura sopra evidenziata sono presenti alcuni cambiamenti rispetto agli esempi precedenti, in particolare la Barra
degli Strumenti per la Gestione della Sorgente Dati è posta lateralmente a sinistra.

Pannelli e Barre degli strumenti
Cliccando nella Barra dei Menu su Visualizza > Pannelli o Visualizza > Barre degli strumenti 
• si visualizzano i Pannelli e le Barre degli strumenti attivi
• si attivano o disattivano Pannelli e Barre degli strumenti

Ad esempio:
• verifica Pannelli attivi :
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• verifica Barre degli Strumenti attive:

I Pannelli più comunemente utilizzati sono Layer, Browser e Panoramica:

Le barre degli strumenti più comunemente utilizzate sono: 
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Caricamento di un Layer vettoriale  
Un modo per caricare un layer vettoriale, ad esempio Province.shp, è: 
• Barra dei Menu > Layer > Aggiungi Layer >  Aggiungi Layer Vettore… 

si  apre la scheda  Gestore delle Sorgenti Dati |  Vettore dove con   Sfoglia cercare e inserire il file shapefile
Province.shp :

Un altro modo è tramite il Pannello Browser :

Notare che prima di inserire lo shapefile l’EPSG è quello definito per default nella scheda Impostazioni (EPSG:4326)

A caricamento effettuato risulta:
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dopo aver caricato lo shapefile il  sistema di riferimento è cambiato (EPSG:3003), viene assunto quello del layer
caricato.

Caricamento di un Layer raster  
Un modo per caricare un layer vettoriale, ad esempio Toscana_100k.tif, è: 
• Barra dei Menu > Layer > Aggiungi Layer >  Aggiungi Layer Raster…  

si apre la scheda Gestore delle Sorgenti Dati | Raster dove inserire il raster Toscana_100k.tif :

Si poteva anche utilizzare il Pannello Browser, a caricamento effettuato risulta:
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Caricamento di un Progetto  
Caricando il progetto presente nella cartella dati Toscana_Windows.qgs , si ha:

caricando lo stesso progetto con la versione QGIS 3.4 si ha:
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la visualizzazione nell’area mappa è la stessa ma la legenda della versione 3.28 non viene rappresentata in modo
leggibile probabilmente per alcune incompatibilità delle definizioni del progetto nella versione precedente di QGIS e
il sw ora attivo.

Lasciando attivo in visualizzazione solo il layer Srtm_90m si notano alcuni pixel bianchi: sono i pixel per i quali non è
definita (non è stata rilevata) la quota: 

AMFM – Corso ECDL GIS – Modulo 3 - CC BY-NC-ND 3.0 IT – (2023) pag. 16



ANALISI LAYER
In  generale  per  fare  elaborazioni  e  analisi  sui  dati  e  quindi  anche sui  dati  georefenziati  è  necessario  conoscere
l’origine, le caratteristiche e la qualità dei dati che sinteticamente sono descritte in uno specifico documento o in una
scheda sintetica: i così detti metadati. Nelle slide relative al Modulo 1 sono descritti gli standard per documentare la
“Qualità dei Dati” ed è riportato il seguente elenco di informazioni principali utili per documentare i metadati dei
dataset territoriali:
• titolo del dataset
• descrizione in linguaggio naturale del dataset
• soggetto che ha prodotto il dataset (Spesso coincide con il soggetto che pubblica il dataset)
• soggetto che pubblica il dataset (spesso, ma non sempre, coincide con il soggetto che ha prodotto il dataset)
• scopo per il quale è stato creato il dataset e suoi utilizzatori
• soggetto o organizzazione che detiene e gestisce i diritti sul dataset
• soggetto o riferimenti per contattare chi detiene il dataset e modalità di acquisizione 
• lingua nella quale sono espressi i dati e la documentazione
• riferimento spaziale e sistema di coordinate
• estensione spaziale
• validità temporale dei dati (data di ultimo aggiornamento, frequenza di aggiornamento dei dati)
• entità, attributi, scala nominale, accuratezza e completezza dei dati garantita
• parole chiave, separate da virgole, che descrivono il dataset
• licenza utilizzata

Per i dati presenti nella cartella dati dell’ECDL GIS AICA non è presente alcuna descrizione, pertanto di seguito – in
mancanza di metadati -  viene analizzato ogni layer in modo da acquisire una conoscenza preliminare di base sui dati,
conoscenza ritenuta utile per meglio comprendere i quesiti sia del Sample Test sia di quelli che verranno formulati in
sede di esame (se - come finora è sempre stato - i dati per i test di esame non saranno cambiati).  Da tenere presente
che il sw QGIS nella scheda  Proprietà > Informazioni prevederebbe di fornire alcune informazioni sui metadati,
però nel caso dei dati AICA le poche informazioni presenti sono ricavate in automatico dalla tipologia rilevata, dai
contenuti geometrici e dalla tipologia dei dati, ad esempio per il layer Bacini,shp:

Caricamento di tutti i Layer con zoom completo  
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Come è possibile notare dalla figura sopra visualizzata non tutti i layer si sovrappongono: i layer vettoriali  bacini,
comuni e fix non si sovrappongono agli altri layer nonostante la versione di QGIS in uso effettui automaticamente la
trasformazione al volo... (probabile incoerenza tra i file di proiezione prj-qpj e le coordinate degli shapefile).

Sistemi di riferimento e coordinate  
Tutti i layer sono in coordinate piane in EPSG 3003 tranne Province_wgs84.shp che è in EPSG 32632.

EPSG 3003 – Monte Mario / Italy zone 1

EPSG 32632 – WGS 84 /UTM zone 32N

sono due proizioni trasverse di Mercatore simili che differiscono per ellissoide e coordinata piana di falso Est: 
Prj di EPSG 3003 – Monte Mario / Italt zone 1 Prj di EPSG 32632 – WGS 84 /UTM zone 32N

PROJCS["Monte_Mario_Italy_zone_1",GEOGCS["GCS_Monte 
Mario",DATUM["D_Monte_Mario",SPHEROID["International_1924",6378388,297]],
PRIMEM["Greenwich",0],
UNIT["Degree",0.017453292519943295]],
PROJECTION["Transverse_Mercator"],
PARAMETER["latitude_of_origin",0],
PARAMETER["central_meridian",9],
PARAMETER["scale_factor",0.9996],
PARAMETER["false_easting",1500000],
PARAMETER["false_northing",0],
UNIT["Meter",1]]

PROJCS["WGS_1984_UTM_Zone_32N",GEOGCS["GCS_WGS_1984",DATUM["D_WG
S_1984",SPHEROID["WGS_1984",6378137,298.257223563]],
PRIMEM["Greenwich",0],
UNIT["Degree",0.017453292519943295]],
PROJECTION["Transverse_Mercator"],
PARAMETER["latitude_of_origin",0],
PARAMETER["central_meridian",9],
PARAMETER["scale_factor",0.9996],
PARAMETER["false_easting",500000],
PARAMETER["false_northing",0],
UNIT["Meter",1]]
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Confini regionali di inquadramento  
Di seguito nell’analizzare i  layer  viene realizzata una visualizzazione in scala 1:3.000.000 inquadrata sui  confini
regionali della Regione Toscana con linea rossa per i layer sulla sinistra e blu per i layer sulla destra.

Preliminarmente ricaviamo quindi i confini regionali con operazione di “dissolve” sui confini di “bacini.shp” e di
“Province.shp”.

Confini regione Toscana (blu) 
• lanciare QGIS, caricare lo Shapefile bacini, scegliere menu a tendina Vettore > Strumenti di Geoprocessing

> Dissolvi… :

prima di inviare con OK definire il file di output regione_dx_bac.shp nella cartella C:/ECDL

si ottiene il salvataggio del risultato con il nome scelto nella cartella scelta e il caricamento del layer con il
nome scelto
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• generare  solo  linea  di  contorno  della  regione:  selezionare  regione_dx_bac.shp,  scegliere  Proprietà...  >
Simbologia :

si ottiene:

Procedura analoga per “Toscana di sinistra” su Province - colore rosso - regione_sx_prov
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risulta:
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Layer Vettoriali  
Generalità
Nella cartella C:\ECDL\dati sono contenuti 16 shapefile tutti definiti da 5 file (.shp .dbf .shx .prj .qpj) 
I layer vettoriali sono in formato “Shapefile” e contengono una sola tipologia di dati vector (punto o linea o area) e
nella prassi normale sono costituiti dai seguenti 3 File obbligatori:
• .shp - file delle geometrie
• .shx - file indice delle geometrie
• .dbf - database degli attributi

è però opportuno che sia presente il file: 
• .prj - sistema di coordinate

in alcuni casi possono essere presenti uno o più dei seguenti files opzionali:
• .sbn e .sbx - indici di tipo spaziale delle geometrie
• .ain e .aih - indici attributi campi non spaziali
• .shp.xml – metadati dello shapefile

In ambienti QGIS si può aggiungere il file di progetto .qpj , che - se presente - viene utilizzato al posto di .prj.

In generale i due files .prj e .qpj  dovrebbero equivalersi dal punto di vista funzionale.  L'esistenza dei file .qpj è
dovuta ad una più estesa definizione preferita dal sw QGIS in quanto priva di possibili ambiguità del formato prj.

Confronto file .prj e .qpj :

Province.prj Province.qpj
PROJCS["Monte_Mario_Italy_zone_1", PROJCS["Monte Mario / Italy zone 1",

GEOGCS["GCS_Monte Mario", GEOGCS["Monte Mario",

DATUM["D_Monte_Mario", DATUM["Monte_Mario",

SPHEROID["International_1924",6378388,297]], SPHEROID["International 1924",6378388,297,

PRIMEM["Greenwich",0], AUTHORITY["EPSG","7022"]],

UNIT["Degree",0.017453292519943295]], TOWGS84[-104.1,-49.1,-9.9,0.971,-2.917,0.714,-11.68],

PROJECTION["Transverse_Mercator"], AUTHORITY["EPSG","6265"]],

PARAMETER["latitude_of_origin",0], PRIMEM["Greenwich",0,

PARAMETER["central_meridian",9], AUTHORITY["EPSG","8901"]],

PARAMETER["scale_factor",0.9996], UNIT["degree",0.0174532925199433,

PARAMETER["false_easting",1500000], AUTHORITY["EPSG","9122"]],

PARAMETER["false_northing",0], AUTHORITY["EPSG","4265"]],

UNIT["Meter",1]] PROJECTION["Transverse_Mercator"],

PARAMETER["latitude_of_origin",0],

PARAMETER["central_meridian",9],

PARAMETER["scale_factor",0.9996],

PARAMETER["false_easting",1500000],

PARAMETER["false_northing",0],

UNIT["metre",1,

AUTHORITY["EPSG","9001"]],

AXIS["X",EAST],

AXIS["Y",NORTH],

AUTHORITY["EPSG","3003"]]

Note sui campi area e perimetro della tabella degli attributi
E’ prassi comune che nella tabella degli attributi dei vettori poligono ci siano campi con il perimetro e l’area di
ciascun poligono e che nella tabella degli attributi dei vettori linea ci sia il campo lunghezza di ciascuna linea.

Si ritiene inutile la presenza di tali campi e anzi fuorviante se non viene descritto nei metadati come è stata calcolata:
spesso  si  trovano  errori  evidenti,  calcoli  effettuati  prima  di  generalizzazione,  valori  che  nel  caso  di  vettori
multipoligono o vettori multilinea sono riferiti all’area o alla linea complessiva di ciascuna entità, calcoli che non si sa
se riferiti a proiezione piana o a superficie ellissoidica. 

Quindi nelle analisi seguenti si considerano come inesistenti.
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Layer vettoriale bacini.shp
Vettore di poligoni con coordinate incoerenti con prj/qpj (risulterebbe EPSG:3033 Monte_Mario_Italy_zone_1 ma le
coordinate sono incoerenti), caricamento layer bacini.shp e caricamento regione_dx_bac

Scegliendo:

Proprietà… > Simbologia = Categorizzato e Valore = DESCR > Random colors > Classifica > OK 

Tabella degli attributi (37 poligoni e 7 campi):

i 7 campi: 
cat AREA   PERIMETER BAC183_       BAC183_ID BACINO       DESCR

unico campo che sembra essere significativo è DESCR.

Si notano righe in cui il contenuto di DESCR è uguale (nei bacini rappresentati da più poligoni) pertanto con: 

bacini > Vettore > Strumento di Geoprocessing > Dissolvi… [in Dissolto  DESCR] 

si ottiene un layer multipoligono, i bacini sono 12 (solo alcuni sono multipoligono) per i quali nella tabella attributi ha
senso solo il  campo DESCR (gli  altri  campi hanno valori fuorvianti:  prendono i valori dal primo poligono della
tabella originaria) 
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Layer vettoriale comuni.shp
Vettore di poligoni con coordinate incoerenti con prj/qpj (risulterebbe EPSG:3033 Monte_Mario_Italy_zone_1 ma le
coordinate sono incoerenti), caricamento layer comuni.shp e caricamento regione_dx_bac

Scegliendo:
Proprietà… > Simbologia = Categorizzato e Valore = NOMEMAI > Random colors > Classifica > OK 

Tabella degli attributi (313 poligoni e 69 campi):

numero di campi privo di metadati comunque troppo elevato, i 69 campi:
cat  AREA  PERIMETER COMUNI_ COMUNI_ID CODISTAT91 CODISTAT81 
CISTAT81 CISTAT91 CODREGIO PROVINCIA NOMEMAI NOMEMIN SISINSTO 
DISTIND91 DISTIND81 SISTLOC81 PIMEGR81 CENSIS81 SISTLOC91 CENSIS91  
NUMSIS91 POSLAV91 OCCRES91 SPOINT91  AUTDOM91 AUTOFF91 OFFDOM91 
SERIMP91  SERCON91  PIMEGR91 SUP_ISTAT AMB_OTT_RI BAC_MINER F_COSTIERA
P_USL_ID P_USL_DESC USL_ID USL_DESC USL_ZONA D_SCOL_ID D_SCOL_DES  
SEZCOL_ID SEZCOL_DES APT_ID  APT_DESC APT_DES POP1951 POP1961 
POP1971 POP1981 POP1991 CODICE_ARE DESCR_AREA CODICE_DIS DESCR_DIS 
PREFISSO CODREGIO91 CODPROV91 CODCOM91 CODREGIO81 CODPROV81 CODCOM81  
COM CIST81 SISL81 USLZONA   USL COD

i campi significativi potrebbero essere quelli di origine ISTAT:

CODISTAT91 CODISTAT81 CISTAT81        CISTAT91
PROVINCIA NOMEMAI NOMEMIN POP1951
POP1961 POP1971 POP1981 POP1991

e quindi la tabella attributi si ridurrebbe a 313 poligoni e 12 campi:

In tabella ci sono comuni che nei censimenti ISTAT del 1951 e/o 1961 non esistevano, pertanto sono riportati con
abitanti pari a zero:
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da evidenziare anche che la popolazione nei diversi poligoni dei comuni formati da più poligoni è riferita al comune
intero.

Si notano righe (poligoni)  in cui il contenuto di NOMEMAI (o NOMEMIN) è uguale (comuni che hanno isole fisiche
o isole amministrative in altri comuni) pertanto con: 

bacini > Vettore > Strumento di Geoprocessing > Dissolvi… [in Dissolto  NOMEMAI] 

si ottiene un layer multipoligono, i comuni distinti sono 287 (solo alcuni sono multipoligono) 
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Layer vettoriale fix.shp
Vettore di punti con coordinate incoerenti  con prj/qpj (risulterebbe EPSG:3033 Monte_Mario_Italy_zone_1 ma le
coordinate sono incoerenti), caricamento layer comuni.shp e caricamento regione_dx_bac

Tabella degli attributi (1.645 punti e 7 campi):
cat      cat_      cova      data      id_radio      nido

dati incomprensibili
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Layer vettoriale Idrografia.shp
Vettore di linee nel sistema EPSG:3033 (Monte_Mario_Italy_zone_1) caricamento layer Idrografia.shp e caricamento
regione_sx_prov

Scegliendo:

Proprietà… > Simbologia > Colore = blu > OK 

Tabella degli attributi (4.916 linee e 13 campi):

cat FNODE_ TNODE_ LPOLY_    
RPOLY_  LENGTH  ELENCO  ELENCO230_  
CODICE  NOME  NOME_CORSO AMBITO   
CODICEA

Incomprensibile  il  significato  di  alcuni  campi  (alcuni  campi  probabilmente  derivano  da  passaggio  a  struttura
topologica arco-nodo a shapefile) e campi inutili, campi con valori mancanti o incompleti...

Unici campi utili NOME e NOME_CORSO che sono con stesso contenuto 

Dissolvendo su NOME (o NOME_CORSO che è uguale a NOME) si hanno 2.387 corsi d’acqua distinti
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Layer vettoriale idrografia_firenze.shp
Vettore  di  linee  nel  sistema EPSG:3033 (Monte_Mario_Italy_zone_1)  caricamento  layer  idrografia_firenze.shp e
caricamento regione_sx_prov

Scegliendo:
Proprietà… > Simbologia > Colore = blu > OK 

Tabella degli attributi (750 linee e 13 campi):
cat a_FNODE_ a_TNODE_ a_LPOLY_   
a_RPOLY_ a_LENGTH  a_ELENCO  a_ELENCO23
a_CODICE  a_NOME   a_NOME_COR a_AMBITO  
a_CODICEA

i campi con alcuni nomi cambiati sono gli stessi di Idrografia.shp, il layer risulta essere un ritaglio di Idrografia.shp

Incomprensibile  il  significato  di  alcuni  campi  (alcuni  campi  probabilmente  derivano  da  passaggio  a  struttura
topologica arco-nodo a shapefile) e campi inutili, campi con valori mancanti o incompleti...
Unici campi utili a_NOME e a_NOME_COR che sono con stesso contenuto 

Dissolvendo su a_NOME (o su a_NOME_COR che è uguale a a_NOME) si hanno 376 corsi d’acqua distinti
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Layer vettoriale Parchi_nazionali.shp
Vettore di poligoni nel sistema EPSG:3033 (Monte_Mario_Italy_zone_1) caricamento layer  Parchi_nazionali.shp e
caricamento regione_sx_prov

Tabella degli attributi (292 poligoni e 8 campi):
cat      AREA      PERIMETER      AP_PN_      AP_PN_ID      CODICE      NOME      TIPO

Unici campi utili CODICE e NOME

Dissolvendo su NOME (o su CODICE) si hanno 3 parchi nazionali distinti
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Layer vettoriale Province.shp
Vettore  di  poligoni  nel  sistema  EPSG:3033  (Monte_Mario_Italy_zone_1)  caricamento  layer  Province.shp e
caricamento regione_sx_prov

Scegliendo:

Proprietà… > Simbologia = Categorizzato e Valore = PROVINCIA > Random colors > Classifica > OK 

Tabella degli attributi (29 poligoni e 5 campi):

cat      AREA       PERIMETER      PROVINCIA      ETTARI

Unico campo utile PROVINCIA

Notare l’errore dell’area negativa su alcuno poligoni

Dissolvendo su PROVINCIA si hanno 10 poligoni: le 10 province della Toscana (compresa Prato istituita nel 1992:
AR Arezzo – FI Firenze – GR Grosseto – LI Livorno – LU Lucca – MS Massa Carrara – PI Pisa – PO Prato – PT Pistoia – SI Siena)
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Layer vettoriale Province_wgs84.shp
Vettore di poligoni nel sistema EPSG:32632 (WGS 84 / UTM zone 32N) caricamento layer  Province_wgs84.shp e
caricamento regione_sx_prov

Scegliendo:

Proprietà… > Simbologia = Categorizzato e Valore = PROVINCIA > Random colors > Classifica > OK  

Nota:  il  layer  Province_wgs84 ha  internamente  un  diverso  EPSG (32632 invece  di  3003)  ma essendo attiva  la
riproiezione al volo risulta visualizzato in EPSG 3003

Caricando Province_wgs84 in un nuovo Progetto risulterebbe invece:

quindi risulterebbe EPSG = 32632.

Tabella degli attributi (29 poligoni e 5 campi): uguali allo shapefile Province.shp

cat      AREA       PERIMETER      PROVINCIA      ETTARI

con stesso errore sulla superficie di alcuni poligoni.
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Layer vettoriale riserve_provinciali.shp
Vettore di poligoni nel sistema EPSG:3033 (Monte_Mario_Italy_zone_1) caricamento layer riserve_provinciali.shp e
caricamento regione_sx_prov

Tabella degli attributi (54 poligoni e 9 campi):
cat      AREA      PERIMETER      AP_RNP_       AP_RNP_ID      ISTAT      CODICE      NOME      TIPO

sono utilizzabili e comprensibili solo i campi ISTAT, CODICE e NOME 

Dissolvendo su NOME si hanno 36 riserve provinciali distinte

Dissolvendo su NOME + CODICE si hanno 41 riserve provinciali distinte
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Layer vettoriale riserve_valdinievole.shp
Vettore di poligoni nel sistema EPSG:3033 (Monte_Mario_Italy_zone_1) caricamento layer riserve_valdinievole.shp
e caricamento regione_sx_prov

Tabella degli attributi (54 poligoni e 11 campi):
cat                     a_cat              b_cat               b_AREA       b_PERIMETE        b_AP_RNP_       

b_AP_RNP_I   b_ISTAT        b_CODICE     b_NOME      b_TIPO

sono utilizzabili e comprensibili solo i campi b_ISTAT,  b_CODICE e b_NOME 

Dissolvendo su b_NOME si hanno solo 2 riserve Valdinievole distinte

Da notare che aggiungendo 2 campi  area e  perimetro definiti  con il  Calcolatore di Campi risultano chiaramente
fuorvianti i valori b_Area e b_PERIMETE della tabella attributi originaria:
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Layer vettoriale sottobacini.shp
Vettore  di  poligoni  nel  sistema  EPSG:3033  (Monte_Mario_Italy_zone_1)  caricamento  layer  sottobacini.shp e
caricamento regione_sx_prov

Scegliendo:

Proprietà… > Simbologia = Categorizzato e Valore = NOMEMAI > Random colors > Classifica > OK 

Tabella degli attributi (1.105 poligoni e 19 campi):
Cat AREA PERIMETER BACIDRO_ BACIDRO_ID CODICE DESCRIZION

L1 L2 L3 L4 L5 L6 K1

K2 K3 K4 K5 K6

è utilizzabile e comprensibile solo il campo DESCRIZION 

Dissolvendo su DESCRIZION si hanno solo 1.069 sottobacini distinti
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Layer vettoriale Strade_regionali.shp
Vettore  di  linee  nel  sistema  EPSG:3033  (Monte_Mario_Italy_zone_1)  caricamento  layer  Strade_regionali.shp e
caricamento regione_sx_prov

Tabella degli attributi (270 linee e 12 campi):
cat    FNODE_    TNODE_    LPOLY_    RPOLY_    LENGTH     STATALI_     STATALI_ID    CODICE    NOME    TIPO    CODIFICA

è utilizzabile e comprensibile solo il campo NOME 

Dissolvendo su NOME si hanno solo 21 strade regionali distinte
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Layer vettoriale strade_statali.shp
Vettore  di  linee  nel  sistema  EPSG:3033  (Monte_Mario_Italy_zone_1)  caricamento  layer  strade_statali.shp e
caricamento regione_sx_prov

Tabella degli attributi (207 linee e 12 campi):
cat    FNODE_    TNODE_    LPOLY_    RPOLY_    LENGTH     STATALI_     STATALI_ID    CODICE    NOME    TIPO    CODIFICA

è utilizzabile e comprensibile solo il campo NOME. Dissolvendo su NOME si hanno solo 13 strade statali distinte, la
strada con NOME NULL è la strada statale 3bis “Tiberina”:
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Layer vettoriale superstrada.shp
Vettore  di  linee  nel  sistema  EPSG:3033  (Monte_Mario_Italy_zone_1)  caricamento  layer  superstrada.shp e
caricamento regione_sx_prov

Tabella degli attributi (40 linee e 17 campi):
cat FNODE_ TNODE_ LPOLY_ RPOLY_ LENGTH AUTOSTRADE  
AUTOSTRAD    QUADRANTE  TIPO_STRAD    CODICE_STR    CAR_TRATTO  CODICE_PAR    CAR_PART    
CODICE_ARR   CAR_ARR  DXF_LAYER 
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Campi privi di descrizione, è la superstrada Firenze – Pisa – Livorno. 

L’unico campo che ha senso utilizzare è CODICE_STR che però ha in una linea (riga 40) valore NULL, tale riga è
completamente priva di codifica anche negli altri campi ed è il tratto terminale di collegamento a Livorno come risulta
dissolvendo sul campo CODICE_STR:
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Layer vettoriale urbano.shp
Vettore di poligoni nel sistema EPSG:3033 (Monte_Mario_Italy_zone_1) caricamento layer urbano.shp e caricamento
regione_sx_prov

Tabella degli attributi (899 poligoni e 24 campi):
cat AREA PERIMETER CENUCL91_ CENUCL91_I CODISTAT91 CODISTAT81
NOMECOM91 CODREGIO91 PROV91 NOMELOC91 TIPOSEZ91 AMM CONTEST
NOMEMIN QUOTA POPOL91 MASCHI91 FAMIGLIE91 ABITAZ91 DENSPOP91
SECOMUN X_COORD Y_COORD

                                                                                                    (visualizzazione righe parziale)

Sembrano  utilizzabili  e  comprensibili  i  campi  CODISTAT91,  CODISTAT81,  NOMECOM91,  PROV91,
NOMELOC91,  QUOTA,  POPOL91,  MASCHI91,  FAMIGLIE91,  ABITAZ91,  DENSPOP91,  X_COORD,
Y_COORD
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Layer vettoriale vincolo_paesaggistico.shp
Vettore  di  poligoni  nel  sistema  EPSG:3033  (Monte_Mario_Italy_zone_1)  caricamento  layer
vincolo_paesaggistico.shp e caricamento regione_sx_prov

Tabella degli attributi (135 poligoni e 9 campi):
Cat     a_AREA     a_PERIMETE     a_VT_PAE1A     a_COD_SBA     a_BENE_ID     a_DATA     a_LEGGE     a_COD_REG 

Incomprensibile il significato dei campi.
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Layer Raster  
Generalità sui raster
Premessa informativa generale sui dati raster
I layer raster sono file costituiti da celle (pixel) generalmente quadrate o rettangolari organizzate in righe e colonne e georeferenziate. Ogni
pixel ha un valore associato. Un layer raster è costituito da una griglia di celle - una matrice di celle - organizzate in righe e colonne. Ogni
cella ha un valore che rappresenta l’informazione della cella. 

Le informazioni in un layer raster possono essere codificate: 

• con un solo bit (0 -1 bianco-nero) per pixel, 

• un byte: 8 bit per ciascun pixel (256 possibili codifiche - generalmente una scala di grigi, ovvero 256 possibili associazioni in alcuni
casi associati a una tavolozza – palette - di colori codificati con il sistema RGB)

• tre byte 256x256x256=16.777.216 colori-codifiche diverse

Overview dei dati raster presenti nella certificazione ECDL AICA

I  formati  dei  file  raster  possono  essere  diversi  (vedere  le  slide  relative  del  Modulo  2  –  GIS).  Nel  caso  dei  layer  raster  presenti  nella
certificazione ECDL AICA sono tutti di tipo geotiff, quindi all’interno dei file sono presenti le informazioni relative alla georeferenziazione,
sistema di riferimento e coordinate. Non sono necessari le associazione con world file. I layer sono 4 di diversa tipologia: 

• esposizione_100m.tif:  Pixel  25 x  25 metri.  Generalità  sui  dati  che  rappresentano l’esposizione (aspect)1 :  l’esposizione di  una
superficie esprime l’orientamento dei versanti rispetto ai punti cardinali. Può essere considerata come la direzione della pendenza. Si
misura in gradi rispetto alla direzione del Nord geografico (0 rivolta verso Nord, 90 rivolta verso Est, 180 Sud e 270 Ovest). 

• landsat_rgb.tif: Pixel 90 x 90 metri. Premessa informativa generale sui dataset Landsat: Landsat è il nome di una serie di satelliti
scientifici americani destinati all'osservazione della superficie della Terra in differenti intervalli dello spettro di radiazioni. A seconda
dell’intervallo della banda è possibile effettuare:
◦ lo studio delle aree costiere, batimetrie e distinzione fra suoli e vegetazione
◦ l’analisi dello stato di salute della vegetazione attraverso il suo contenuto in clorofilla
◦ la distinzione tra classi di vegetazione
◦ l’evoluzione della biomassa fogliare della vegetazione e della linea di costa
◦ la distinzione fra neve e nuvole, contenuto di umidità nei suoli e nella vegetazione
◦ lo studio della temperatura, mappatura termica ed umidità nei suoli
◦ la discriminazione litologica

• srtm_90m.tif:  Pixel  circa  90 x  90  metri.  Generalità  sui dataset  SRTM:  sono  file  che  rappresentano  con  buona  precisione  ed
accuratezza il modello digitale di elevazione del terreno (DEM): 
◦ SRTM sta per Shuttle Radar Topography Mission, i dati topografici e di elevazione sono stati rilevati nel 2000 dallo Space

Shuttle Endeavour tramite un sofisticato radar-altimetro ad apertura sintetica 
◦ la cella elementare di misurazione (pixel) corrisponde a 3 secondi d'arco quadrati, ossia a circa 90m x 90m misurati sul terreno 
◦ un problema presente in questa metodologia basata su misurazioni radar è che alcuni materiali (neve, sabbia ...) offrono una

riflettività anomala, tale da impedire qualsiasi misurazione affidabile. Quindi in alcune aree (alta montagna, deserti, distese di
acqua ...) esistono pixel ma anche regioni (a volte estese) prive di misura (NODATA) 

◦ i raster SRTM utilizzano il Sistema di Riferimento Spaziale WGS84 long/lat [codice EPSG: 4326], ma nel dataset AICA sono
stati trasformati nel sistema EPSG 3033 MonteMario Italy Zone 1

• toscana_100k.tif: Pixel 90 x 90 metri. E’ un raster che rappresenta la scannerizzazione del 100.000 IGM della regione Toscana.

File ausiliari
Nella cartella dati della certificazione ECDL GIS sono presenti:

2 world file srtm_90m.tfw e toscana_100k.tfw che in realtà non servono in quanto i relativi tif sono di tipo geotiff.

 

1 Da non confondere con l’ombreggiatura (hillshade) che è una rappresentazione 3D in scala di grigi della superficie del suolo che tiene in considerazione la
posizione relativa del sole per ombreggiare l’immagine.
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Layer raster esposizione_100m.tif
Non sono noti i metadati del layer landsat.rgb della certificazione ECDL GIS AICA. 
Ricaviamo alcune informazioni dagli strumenti disponibili in QGIS: è un geotiff quindi oltre ai “dati immagine” (dati
sui pixel) il file contiene informazioni sul sistema di riferimento e sulla georeferenziazione (definizione matrice pixel,
origine della matrice, estensione, dimensioni e definizione dei pixel, Banda e Color Table, valore pixel NoData).
In sintesi alcuni dati sono: EPSG 3003, numero colonne 8.678 e numero righe 9.859, pixel 25 x 25 metri, dato pixel
Byte - intero senza segno di 8 bit (valori da 0 a 255), sono visibili solo i pixel con valore da 0 a 249 nella Color Table,
NoData valore 255, nella Color Table (255:0,0,0,0)

esposizione_100m.tif: Proprietà… > Informazioni

Generale

Nome esposizione_100m

Percorso C:\ECDL\dati\esposizione_100m.tif

Dimensione 81.80 MB

Ultima modifica martedì 8 maggio 2012 15:04:42

Sorgente dati gdal

Informazioni dalla sorgente

Estensione
1554720.1640625300351530,4678300.5000000903382897 : 
1771670.1640625300351530,4924775.5000000903382897

Larghezza 8678

Altezza 9859

Tipo di Dato Byte - intero senza segno di 8 bit

Descrizione Driver GDAL GTiff

Metadato Driver GDAL GeoTIFF

Descrizione dell'insieme di 
dati

C:\ECDL\dati\esposizione_100m.tif

Compressione

Banda 1 • COLOR_TABLE_RULES_COUNT=256

• COLOR_TABLE_RULE_RGB_0=0.000000e+000 0.000000e+000 0 0 0 0 0 0

• COLOR_TABLE_RULE_RGB_1=1.000000e+000 1.000000e+000 1 1 1 1 1 1
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• ….omissis….

• COLOR_TABLE_RULE_RGB_99=9.900000e+001 9.900000e+001 99 99 99 99 99 99

• STATISTICS_APPROXIMATE=YES

• STATISTICS_MAXIMUM=249

• STATISTICS_MEAN=149.36487600089

• STATISTICS_MINIMUM=0

• STATISTICS_STDDEV=26.051707898083

• STATISTICS_VALID_PERCENT=42.93

• Scala: 1

• Offset: 0

Maggiori informazioni • AREA_OR_POINT=Area

Dimensioni X: 8678 Y:.9859 Bande: 1

Origine 1554720.1640625300351530,4924775.5000000903382897

Dimensione Pixel 25,-25

Sistema di riferimento (SR)

Nome EPSG:3003 - Monte Mario / Italy zone 1

Unità metri

Metodo Transverse Mercator

Corpo celeste Earth

Riferimento Statico (si basa su un datum che è fissato sulla placca tettonica)

Identificazione
Estensione
Accesso

Bande
Numero bande 1

Numero Banda No-Data Min Max

1 Banda 1 255 0.0000000000 249.0000000000

Contatti
Riferimenti
Cronologia

esposizione_100m.tif: Raster > Miscellanea > Informazioni raster...

Driver: GTiff/GeoTIFF
Files: C:\ECDL\dati\esposizione_100m.tif
Size is 8678, 9859
Coordinate System is:
PROJCRS["Transverse Mercator",
    BASEGEOGCRS["unnamed",
        DATUM["unknown",
            ELLIPSOID["unnamed",6378388,297,
                LENGTHUNIT["metre",1,
                    ID["EPSG",9001]]]],
        PRIMEM["Greenwich",0,
            ANGLEUNIT["degree",0.0174532925199433,
                ID["EPSG",9122]]]],
    CONVERSION["Transverse Mercator",
        METHOD["Transverse Mercator",
            ID["EPSG",9807]],
        PARAMETER["Latitude of natural origin",0,
            ANGLEUNIT["degree",0.0174532925199433],
            ID["EPSG",8801]],
        PARAMETER["Longitude of natural origin",9,
            ANGLEUNIT["degree",0.0174532925199433],
            ID["EPSG",8802]],
        PARAMETER["Scale factor at natural origin",0.9996,
            SCALEUNIT["unity",1],
            ID["EPSG",8805]],
        PARAMETER["False easting",1500000,
            LENGTHUNIT["metre",1],
            ID["EPSG",8806]],
        PARAMETER["False northing",0,
            LENGTHUNIT["metre",1],
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            ID["EPSG",8807]]],
    CS[Cartesian,2],
        AXIS["easting",east,
            ORDER[1],
            LENGTHUNIT["metre",1,
                ID["EPSG",9001]]],
        AXIS["northing",north,
            ORDER[2],
            LENGTHUNIT["metre",1,
                ID["EPSG",9001]]]]
Data axis to CRS axis mapping: 1,2
Origin = (1554720.164062530035153,4924775.500000090338290)
Pixel Size = (25.000000000000000,-25.000000000000000)
Metadata:
  AREA_OR_POINT=Area
Image Structure Metadata:
  INTERLEAVE=BAND
Corner Coordinates:
Upper Left  ( 1554720.164, 4924775.500) (  9d41'16.72"E, 44d28'24.24"N)
Lower Left  ( 1554720.164, 4678300.500) (  9d39'48.05"E, 42d15'15.25"N)
Upper Right ( 1771670.164, 4924775.500) ( 12d24'45.82"E, 44d25'28.05"N)
Lower Right ( 1771670.164, 4678300.500) ( 12d17'26.88"E, 42d12'32.12"N)
Center      ( 1663195.164, 4801538.000) ( 11d 0'48.53"E, 43d20'53.50"N)
Band 1 Block=8678x1 Type=Byte, ColorInterp=Palette
    Computed Min/Max=0.000,249.000
  Minimum=0.000, Maximum=249.000, Mean=149.304, StdDev=26.200
  NoData Value=255
  Metadata:
    COLOR_TABLE_RULES_COUNT=256
    COLOR_TABLE_RULE_RGB_0=0.000000e+000 0.000000e+000 0 0 0 0 0 0
    COLOR_TABLE_RULE_RGB_1=1.000000e+000 1.000000e+000 1 1 1 1 1 1
    COLOR_TABLE_RULE_RGB_10=1.000000e+001 1.000000e+001 10 10 10 10 10 10
    COLOR_TABLE_RULE_RGB_100=1.000000e+002 1.000000e+002 100 100 100 100 100 100
    COLOR_TABLE_RULE_RGB_101=1.010000e+002 1.010000e+002 101 101 101 101 101 101
    COLOR_TABLE_RULE_RGB_102=1.020000e+002 1.020000e+002 102 102 102 102 102 102
    COLOR_TABLE_RULE_RGB_103=1.030000e+002 1.030000e+002 103 103 103 103 103 103
    COLOR_TABLE_RULE_RGB_104=1.040000e+002 1.040000e+002 104 104 104 104 104 104
    COLOR_TABLE_RULE_RGB_105=1.050000e+002 1.050000e+002 105 105 105 105 105 105
    COLOR_TABLE_RULE_RGB_106=1.060000e+002 1.060000e+002 106 106 106 106 106 106
    COLOR_TABLE_RULE_RGB_107=1.070000e+002 1.070000e+002 107 107 107 107 107 107
    COLOR_TABLE_RULE_RGB_108=1.080000e+002 1.080000e+002 108 108 108 108 108 108
    COLOR_TABLE_RULE_RGB_109=1.090000e+002 1.090000e+002 109 109 109 109 109 109
    COLOR_TABLE_RULE_RGB_11=1.100000e+001 1.100000e+001 11 11 11 11 11 11
    COLOR_TABLE_RULE_RGB_110=1.100000e+002 1.100000e+002 110 110 110 110 110 110
    COLOR_TABLE_RULE_RGB_111=1.110000e+002 1.110000e+002 111 111 111 111 111 111
    COLOR_TABLE_RULE_RGB_112=1.120000e+002 1.120000e+002 112 112 112 112 112 112
 ...omissis...
    COLOR_TABLE_RULE_RGB_9=9.000000e+000 9.000000e+000 9 9 9 9 9 9
    COLOR_TABLE_RULE_RGB_90=9.000000e+001 9.000000e+001 90 90 90 90 90 90
    COLOR_TABLE_RULE_RGB_91=9.100000e+001 9.100000e+001 91 91 91 91 91 91
 ...omissis...
    COLOR_TABLE_RULE_RGB_99=9.900000e+001 9.900000e+001 99 99 99 99 99 99
    STATISTICS_MAXIMUM=249
    STATISTICS_MEAN=149.30352177032
    STATISTICS_MINIMUM=0
    STATISTICS_STDDEV=26.200335514935
    STATISTICS_VALID_PERCENT=43.16
  Color Table (RGB with 256 entries)
    0: 0,0,0,255
    1: 1,1,1,255
    2: 2,2,2,255
    3: 3,3,3,255
 ...omissis...
  248: 247,247,247,255
  249: 248,248,248,255
  250: 0,0,0,255
  251: 0,0,0,255
  252: 0,0,0,255
  253: 0,0,0,255
  254: 0,0,0,255
  255: 0,0,0,0

esposizione_100m.tif: Processing > Strumenti > Analisi Raster > Report valori univoci del layer raster

'HEIGHT_IN_PIXELS': 9859,
'NODATA_PIXEL_COUNT': 48626850,
'OUTPUT_HTML_FILE': 'C:/Users/matti/AppData/Local/Temp/processing_FnzMmg/47fbc7910c2e4eee99e80cdaeb1d1f15/
OUTPUT_HTML_FILE.html',
'TOTAL_PIXEL_COUNT': 85556402,
'WIDTH_IN_PIXELS': 8678}
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esposizione_100m.tif: Pannello Value Tool

 punto fuori da estensione, valore “out of extent”:

 punto nell’estensione ma non oggetto di elaborazione per esposizione, valore “no data”:

 punto nell’estensione oggetto di elaborazione per esposizione:
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Layer raster landsat_rgb.tif

Non sono noti i metadati del layer landsat_rgb della certificazione ECDL GIS AICA. 
Ricaviamo alcune informazioni dagli strumenti disponibili in QGIS: è’ un geotiff per cui oltre ai “dati immagine”
(dati sui pixel) contiene informazioni sul sistema di riferimento e sulla georeferenziazione (definizione matrice pixel,
origine della matrice, estensione, dimensioni e definizione dei pixel, Banda e Color Table, valore pixel NoData).
In sintesi alcuni dati sono: EPSG 3003, numero colonne 2.788 e numero righe 2.458, pixel 90,0159.. metri x 89.9885..
metri, dato pixel UInt16 - Intero senza segno di 16 bit, definizione diverse sui pixel : solo i pixel con valore da 15.848
a 32.767 o 10.570 a 32.767, NoData valore 65535

landsat_rgb.tif: Proprietà… > Informazioni

Generale
Nome landsat_rgb

Percorso C:\ECDL\dati\landsat_rgb.tif

Dimensione 13.86 MB

Ultima modifica martedì 8 maggio 2012 15:05:44

Sorgente dati gdal

Informazioni dalla sorgente
Estensione 1538425.0784119900781661,4672528.8934713499620557 : 1789389.4488280199002475,4893720.6730438498780131

Larghezza 2788

Altezza 2458

Tipo di Dato UInt16 - Intero senza segno di 16 bit

Descrizione Driver GDAL GTiff

Metadato Driver GDAL GeoTIFF

Descrizione dell'insieme di dati C:\ECDL\dati\landsat_rgb.tif

Compressione

Banda 1

• STATISTICS_APPROXIMATE=YES

• STATISTICS_MAXIMUM=32767

• STATISTICS_MEAN=24858.376527629

• STATISTICS_MINIMUM=15848

• STATISTICS_STDDEV=3248.7194354591

• STATISTICS_VALID_PERCENT=59.91

• Scala: 1

• Offset: 0

Maggiori informazioni • AREA_OR_POINT=Area

Dimensioni X: 2788 Y:.2458 Bande: 1

Origine 1538425.0784119900781661,4893720.6730438498780131

Dimensione Pixel 90.01591478336794694,-89.98851894731485856
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Sistema di riferimento (SR)
Nome EPSG:3003 - Monte Mario / Italy zone 1

Unità metri

Metodo Transverse Mercator

Corpo celeste Earth

Riferimento Statico (si basa su un datum che è fissato sulla placca tettonica)

Identificazione
Estensione
Accesso

Bande

Numero bande 1

Numero Banda No-Data Min Max

1 Banda 1 65535 15848.0000000000 32767.0000000000

Contatti
Riferimenti
Cronologia

landsat_rgb.tif: Raster > Miscellanea > Informazioni raster...

Driver: Gtiff/GeoTIFF
Files: C:\ECDL\dati\landsat_rgb.tif
Size is 2788, 2458
Coordinate System is:
PROJCRS["Transverse Mercator",
    BASEGEOGCRS["unnamed",
        DATUM["unknown",
            ELLIPSOID["unnamed",6378388,297,
                LENGTHUNIT["metre",1,
                    ID["EPSG",9001]]]],
        PRIMEM["Greenwich",0,
            ANGLEUNIT["degree",0.0174532925199433,
                ID["EPSG",9122]]]],
    CONVERSION["Transverse Mercator",
        METHOD["Transverse Mercator",
            ID["EPSG",9807]],
        PARAMETER["Latitude of natural origin",0,
            ANGLEUNIT["degree",0.0174532925199433],
            ID["EPSG",8801]],
        PARAMETER["Longitude of natural origin",9,
            ANGLEUNIT["degree",0.0174532925199433],
            ID["EPSG",8802]],
        PARAMETER["Scale factor at natural origin",0.9996,
            SCALEUNIT["unity",1],
            ID["EPSG",8805]],
        PARAMETER["False easting",1500000,
            LENGTHUNIT["metre",1],
            ID["EPSG",8806]],
        PARAMETER["False northing",0,
            LENGTHUNIT["metre",1],
            ID["EPSG",8807]]],
    CS[Cartesian,2],
        AXIS["easting",east,
            ORDER[1],
            LENGTHUNIT["metre",1,
                ID["EPSG",9001]]],
        AXIS["northing",north,
            ORDER[2],
            LENGTHUNIT["metre",1,
                ID["EPSG",9001]]]]
Data axis to CRS axis mapping: 1,2
Origin = (1538425.078411990078166,4893720.673043849878013)
Pixel Size = (90.015914783367947,-89.988518947314859)
Metadata:
  AREA_OR_POINT=Area
Image Structure Metadata:
  INTERLEAVE=BAND
Corner Coordinates:
Upper Left  ( 1538425.078, 4893720.673) (  9d28'50.97"E, 44d11'41.58"N)
Lower Left  ( 1538425.078, 4672528.893) (  9d27'55.56"E, 42d12'11.63"N)
Upper Right ( 1789389.449, 4893720.673) ( 12d37' 3.73"E, 44d 8'18.87"N)
Lower Right ( 1789389.449, 4672528.893) ( 12d30' 7.90"E, 42d 9' 2.46"N)
Center      ( 1663907.264, 4783124.783) ( 11d 1' 0.41"E, 43d10'56.43"N)
Band 1 Block=2788x1 Type=UInt16, ColorInterp=Palette
    Computed Min/Max=10570.000,32767.000
  Minimum=10570.000, Maximum=32767.000, Mean=24844.933, StdDev=3236.555
  NoData Value=65535
  Metadata:
    STATISTICS_MAXIMUM=32767
    STATISTICS_MEAN=24844.933173269
    STATISTICS_MINIMUM=10570
    STATISTICS_STDDEV=3236.5551007845
    STATISTICS_VALID_PERCENT=60.92
  Color Table (RGB with 65536 entries)
    0: 0,0,0,255
    1: 8,0,0,255
    2: 16,0,0,255
...omissis…
10569: 74,82,82,255
10570: 82,82,82,255
10571: 90,82,82,255
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...omissis…
15847: 57,123,123,255
15848: 65,123,123,255
15849: 74,123,123,255
...omissis…
32766: 246,255,255,255
32767: 255,255,255,255
32768: 0,0,0,255
32769: 0,0,0,255
...omissis…
65533: 0,0,0,255
65534: 0,0,0,255
65535: 0,0,0,0

landsat_rgb.tif: Processing > Strumenti > Analisi Raster > Report valori univoci del layer raster

'HEIGHT_IN_PIXELS':2458,
'NODATA_PIXEL_COUNT':2677928,
'OUTPUT_HTML_FILE':'C:/Users/matti/AppData/Local/Temp/processing_DFsGjI/1adf967d8bec4b6b8bc1959edb106492/
OUTPUT_HTML_FILE.html',
'TOTAL_PIXEL_COUNT':6852904,
'WIDTH_IN_PIXELS': 2788}

landsat_rgb.tif: Processing > Strumenti > Strumenti Raster > Riempi celle NoData

Utile per visualizzare nell’area della visualizzazione mappa l’estensione del raster comprese le celle NoData: 

landsat_rgb.tif: Pannello Value Tool
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Utilizzo altri strumenti

Con Informazione Elementi su un pixel: 

Per visualizzare il layer nella risoluzione originale: Visualizza > Pannelli > Panoramica posizionarsi zoomando su
Isola d'Elba scegliere Mostra nella Panoramica, Visualizza > Zoom alla Risoluzione Originale o clic su  :

Dimensioni pixel del raster landsat_rgb.tif: 
passare a una scala esagerata posizionarsi su Isola d'Elba attivare Visualizza >Misura >Misura linea  misurando la
distanza tra due lati di una cella, si trova il valore 90,466 m vicino al valore dichiarato di 90 metri (approssimato per
incertezza di collimazione) 
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Layer raster srtm_90m.tif

Non sono noti i metadati del layer srtm_90m.tif della certificazione ECDL GIS AICA. 
Ricaviamo  alcune  informazioni  dagli  strumenti  disponibili  in  QGIS:  E’  un  geotiff  per  cui  la  presenza  del
corrispondente  srtm_90m.tfw non sarebbe necessaria  Il  geotiff  oltre  ai  “dati  immagine” (dati  sui  pixel)  contiene
informazioni sul sistema di riferimento e sulla georeferenziazione (definizione matrice pixel, origine della matrice,
estensione, dimensioni e definizione dei pixel, Banda e Color Table, valore pixel NoData).
In sintesi alcuni dati sono: EPSG 3003, numero colonne 2.455 e numero righe 2.829, pixel 90 x 90 metri, dato pixel
Float64 - numero in virgola mobile di 64 bit, definizione diverse su pixel visibili: solo i pixel con valore da -11 metri
a 1.868 metri o -29685.654 (chiaramente dato mal catalogato) a 2.150 metri, NoData valore 0

srtm_90.tif: Proprietà… > Informazioni

Generale

Nome srtm_90m

Percorso C:\ECDL\srtm_90m.tif

File ausiliari

Dimensione totale 57.50 MB

Ultima modifica martedì 1 maggio 2012 21:51:46 (srtm_90m.tif.aux.xml)

Sorgente dati gdal

Informazioni dalla sorgente

Estensione
1552743.9528639300260693,4672334.3138072397559881 : 
1773693.9528639300260693,4926764.3138072397559881

Larghezza 2455

Altezza 2827

Tipo di Dato Float64 - numero in virgola mobile di 64 bit

Descrizione Driver GDAL GTiff

Metadato Driver GDAL GeoTIFF

Descrizione dell'insieme di 
dati

C:/ECDL/srtm_90m.tif

Compressione

Banda 1 • STATISTICS_APPROXIMATE=YES

• STATISTICS_MAXIMUM=1868
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• STATISTICS_MEAN=317.08271389702

• STATISTICS_MINIMUM=-11

• STATISTICS_STDDEV=270.36429461611

• STATISTICS_VALID_PERCENT=89.26

• Scala: 1

• Offset: 0

Maggiori informazioni • AREA_OR_POINT=Area

Dimensioni X: 2455 Y:.2827 Bande: 1

Origine 1552743.9528639300260693,4926764.3138072397559881

Dimensione Pixel 90,-90

Sistema di riferimento (SR)

Nome EPSG:3003 - Monte Mario / Italy zone 1

Unità metri

Metodo Transverse Mercator

Corpo celeste Earth

Riferimento Statico (si basa su un datum che è fissato sulla placca tettonica)

Identificazione

Estensione

Accesso

Bande

Numero bande 1

Numero Banda No-Data Min Max

1 Banda 1 0 -11.0000000000 1868.0000000000

Contatti

Riferimenti

Cronologia

NOTA BENE : questo report dà valore massimo 1.868 e minimo -11

srtm_90.tif: Raster > Miscellanea > Informazioni raster...

Driver: GTiff/GeoTIFF
Files: C:\ECDL\srtm_90m.tif
Size is 2455, 2827
Coordinate System is:
PROJCRS["Transverse_Mercator",
    BASEGEOGCRS["GCS_Unknown",
        DATUM["unknown",
            ELLIPSOID["Unknown",6378388,297,
                LENGTHUNIT["metre",1,
                    ID["EPSG",9001]]]],
        PRIMEM["Greenwich",0,
            ANGLEUNIT["degree",0.0174532925199433,
                ID["EPSG",9122]]]],
    CONVERSION["Transverse Mercator",
        METHOD["Transverse Mercator",
            ID["EPSG",9807]],
        PARAMETER["Latitude of natural origin",0,
            ANGLEUNIT["degree",0.0174532925199433],
            ID["EPSG",8801]],
        PARAMETER["Longitude of natural origin",9,
            ANGLEUNIT["degree",0.0174532925199433],
            ID["EPSG",8802]],
        PARAMETER["Scale factor at natural origin",0.9996,
            SCALEUNIT["unity",1],
            ID["EPSG",8805]],
        PARAMETER["False easting",1500000,
            LENGTHUNIT["metre",1],
            ID["EPSG",8806]],
        PARAMETER["False northing",0,
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            LENGTHUNIT["metre",1],
            ID["EPSG",8807]]],
    CS[Cartesian,2],
        AXIS["easting",east,
            ORDER[1],
            LENGTHUNIT["metre",1,
                ID["EPSG",9001]]],
        AXIS["northing",north,
            ORDER[2],
            LENGTHUNIT["metre",1,
                ID["EPSG",9001]]]]
Data axis to CRS axis mapping: 1,2
Origin = (1552743.952863930026069,4926764.313807239755988)
Pixel Size = (90.000000000000000,-90.000000000000000)
Metadata:
  AREA_OR_POINT=Area
Image Structure Metadata:
  INTERLEAVE=BAND
Corner Coordinates:
Upper Left  ( 1552743.953, 4926764.314) (  9d39'48.01"E, 44d29'29.22"N)
Lower Left  ( 1552743.953, 4672334.314) (  9d38'19.86"E, 42d12' 2.31"N)
Upper Right ( 1773693.953, 4926764.314) ( 12d26'20.95"E, 44d26'29.64"N)
Lower Right ( 1773693.953, 4672334.314) ( 12d18'44.90"E, 42d 9'16.46"N)
Center      ( 1663218.953, 4799549.314) ( 11d 0'47.45"E, 43d19'49.06"N)
Band 1 Block=128x128 Type=Float64, ColorInterp=Gray
    Computed Min/Max=-29685.654,2150.000
  Minimum=-29685.654, Maximum=2150.000, Mean=248.516, StdDev=346.250
  NoData Value=0
  Metadata:
    STATISTICS_MAXIMUM=2150
    STATISTICS_MEAN=248.51551089309
    STATISTICS_MINIMUM=-29685.654296875
    STATISTICS_STDDEV=346.25024939704
    STATISTICS_VALID_PERCENT=87.84

NOTA BENE : questo report dà valore massimo 2.150 e minimo -29.685,654296875

srtm_90.tif: Processing > Strumenti > Analisi Raster > Report valori univoci del layer raster

'HEIGHT_IN_PIXELS': 2827
'NODATA_PIXEL_COUNT': 844037,
'OUTPUT_HTML_FILE':OUTPUT_HTML_FILE.html',
'TOTAL_PIXEL_COUNT': 6940285,
'WIDTH_IN_PIXELS': 2455

Approfondimento sulla quota max
Da fonti varie i monti più alti della Toscana risultano essere: Monte Prado 2.054 m, Monte Giovo 1.991 m, Monte Vecchio 1.968 m, Monte Rondinaio 1.964 m,
Monte Pisanino 1.946 m, Corno alle Scale 1.945 m, Monte Cella 1.942. La quota 2.150 sembra essere la quota rilevata dal raster di un monte appena oltre il
confine della Toscana in Emilia Romagna (Monte Cimone quota effettiva 2.165) 

Cerchiamo il il valore 2.150 attivando il pannello Value Tool:

srtm_90.tif: Pannello Value Tool
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I pixel che vengono visualizzati bianchi in mare sono no data :

world file srtm_90.tfw

90.0000000000
0.0000000000
0.0000000000
-90.0000000000
1552788.9528639300
4926719.3138072398
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Layer raster toscana_100k.tif
Dovrebbe derivare da una acquisizione tramite scanner dei fogli IGM 1:100.000 con pixel di restituzione pari a 30 x
30 metri. E’ un geotiff per cui la presenza del corrispondente toscana_100k.tfw non è necessaria. I pixel sono definiti
Byte - intero senza segno di  8 bit (valori  da 0 a 255), sono visibili  solo i  pixel con valore 0 nella Color Table
(0:255,255,255,255 nero  per  default),  tutti  gli  altri  pixel  sono trasparenti  NoData  Value=255,  nella  Color  Table
(255:0,0,0,0)

toscana_100k.tif: Proprietà… > Informazioni

Generale

Nome toscana_100k

Percorso C:\ECDL\toscana_100k.tif

Dimensione 60.78 MB

Ultima modifica martedì 1 maggio 2012 21:55:50

Sorgente dati gdal

Informazioni dalla sorgente

Estensione
1552743.9528639300260693,4672304.3138072397559881 : 
1773663.9528639300260693,4926764.3138072397559881

Larghezza 7364

Altezza 8482

Tipo di Dato Byte - intero senza segno di 8 bit

Descrizione Driver GDAL GTiff

Metadato Driver GDAL GeoTIFF

Descrizione dell'insieme di dati C:\ECDL\toscana_100k.tif

Compressione

Banda 1

• RepresentationType=THEMATIC

• STATISTICS_APPROXIMATE=YES

• STATISTICS_MAXIMUM=1

• STATISTICS_MEAN=1

• STATISTICS_MINIMUM=1

• STATISTICS_STDDEV=0

• STATISTICS_VALID_PERCENT=7.365  valore che sembra errato vedere in seguito 8.558

• Scala: 1

• Offset: 0
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Maggiori informazioni • AREA_OR_POINT=Area

Dimensioni X: 7364 Y:.8482 Bande: 1

Origine 1552743.9528639300260693,4926764.3138072397559881

Dimensione Pixel 30,-30

Sistema di riferimento (SR)

Nome EPSG:3003 - Monte Mario / Italy zone 1

Unità metri

Metodo Transverse Mercator

Corpo celeste Earth

Riferimento Statico (si basa su un datum che è fissato sulla placca tettonica)

Identificazione

Estensione

Accesso

Bande

Numero bande 1

Numero Banda No-Data Min Max

1 Banda 1 255 1.0000000000 1.0000000000

Contatti

Riferimenti

Cronologia

toscana_100k.tif: Raster > Miscellanea > Informazioni raster...

Driver: GTiff/GeoTIFF
Files: C:\ECDL\toscana_100k.tif
Size is 7364, 8482
Coordinate System is:
PROJCRS["Transverse_Mercator",
    BASEGEOGCRS["GCS_Unknown",
        DATUM["unknown",
            ELLIPSOID["Unknown",6378388,297,
                LENGTHUNIT["metre",1,
                    ID["EPSG",9001]]]],
        PRIMEM["Greenwich",0,
            ANGLEUNIT["degree",0.0174532925199433,
                ID["EPSG",9122]]]],
    CONVERSION["Transverse Mercator",
        METHOD["Transverse Mercator",
            ID["EPSG",9807]],
        PARAMETER["Latitude of natural origin",0,
            ANGLEUNIT["degree",0.0174532925199433],
            ID["EPSG",8801]],
        PARAMETER["Longitude of natural origin",9,
            ANGLEUNIT["degree",0.0174532925199433],
            ID["EPSG",8802]],
        PARAMETER["Scale factor at natural origin",0.9996,
            SCALEUNIT["unity",1],
            ID["EPSG",8805]],
        PARAMETER["False easting",1500000,
            LENGTHUNIT["metre",1],
            ID["EPSG",8806]],
        PARAMETER["False northing",0,
            LENGTHUNIT["metre",1],
            ID["EPSG",8807]]],
    CS[Cartesian,2],
        AXIS["easting",east,
            ORDER[1],
            LENGTHUNIT["metre",1,
                ID["EPSG",9001]]],
        AXIS["northing",north,
            ORDER[2],
            LENGTHUNIT["metre",1,
                ID["EPSG",9001]]]]
Data axis to CRS axis mapping: 1,2
Origin = (1552743.952863930026069,4926764.313807239755988)
Pixel Size = (30.000000000000000,-30.000000000000000)
Metadata:
  AREA_OR_POINT=Area
Image Structure Metadata:
  INTERLEAVE=BAND
Corner Coordinates:
Upper Left  ( 1552743.953, 4926764.314) (  9d39'48.01"E, 44d29'29.22"N)
Lower Left  ( 1552743.953, 4672304.314) (  9d38'19.85"E, 42d12' 1.34"N)
Upper Right ( 1773663.953, 4926764.314) ( 12d26'19.60"E, 44d26'29.68"N)
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Lower Right ( 1773663.953, 4672304.314) ( 12d18'43.54"E, 42d 9'15.53"N)
Center      ( 1663203.953, 4799534.314) ( 11d 0'46.77"E, 43d19'48.58"N)
Band 1 Block=128x128 Type=Byte, ColorInterp=Palette
    Computed Min/Max=1.000,1.000
  Minimum=1.000, Maximum=1.000, Mean=1.000, StdDev=0.000
  NoData Value=255
  Metadata:
    RepresentationType=THEMATIC
    STATISTICS_MAXIMUM=1
    STATISTICS_MEAN=1
    STATISTICS_MINIMUM=1
    STATISTICS_STDDEV=0
    STATISTICS_VALID_PERCENT=8.558
  Color Table (RGB with 256 entries)
    0: 255,255,255,255
    1: 0,0,0,255
    2: 0,0,0,255
    3: 0,0,0,255
..omissis..
  253: 0,0,0,255
  254: 0,0,0,255
  255: 0,0,0,0

toscana_100k.tif: Processing > Strumenti > Analisi Raster > Report valori univoci del layer raster

'HEIGHT_IN_PIXELS': 8482,
'NODATA_PIXEL_COUNT': 57115970,
'OUTPUT_HTML_FILE': 'C:/Users/matti/AppData/Local/Temp/processing_FnzMmg/f537b9e54fec4b5f8abe55c28324578f/
OUTPUT_HTML_FILE.html',
'TOTAL_PIXEL_COUNT': 62461448,
'WIDTH_IN_PIXELS': 7364}

Controllo percentuale pixel valid 7.365 o 8.558 ?
pixel totali : 8482 x 7364 = 62.461.448 
pixel diversi da NoData :       62.461.448 – 57.115.970 = 5.345.478
percentuale pixel validi : (5.345.478 /  62.461.448) x 100 = 8,55804368

world file toscana_100k.tfw

30.0000000000
0.0000000000
0.0000000000
-30.0000000000
1552758.9528639300
4926749.3138072398
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Svolgimento Sample Test
Istruzioni per lo svolgimento dei Test  
I condidati agli esami troveranno nella stazione PC su cui eseguiranno i Test:

• una versione di QGIS preinstallata (di seguito ipotizziamo la versione LTR 3.28, ma potrebbe essere una
versione  precedente,  comunque  difficilmente  potranno  trovare  una  versione  compatibile  con  alcune  dei
quesiti come le versioni  QGIS 1.7.4 del 2011 e di QGIS 2.2.0 del 2014)

• un programma di elaborazione testo come Word Microsoft o Writer Open Office
• una cartella C:\ECDL o C:\ ECDL 1.7.4 contenente:

◦ due cartelle e un file: 
▪ una cartella dati con i dati per i test 
▪ una cartella  risultati (o  nomecognome_risultati) dove – quando richiesto – salvare le soluzioni in

formato file i layer che verrano creati 
▪ un  file in formato .rtf contenente i  quesiti  e  dove – se richiesto - memorizzare le soluzioni  in

formato  immagine  (questo  file  potrà  essere  del  tipo  nomecognome.rtf in  questo  documento  lo
chiameremo test_cognome_nome.rtf)

Come salvare le soluzioni in formato immagine:

          

         

          

          

           

Salvare solo l’immagine, non il Progetto; per i quesiti che richiedono il salvataggio dei layer creati salvare i layer
nella cartella Risultati. Terminata la soluzione al test andare su Progetto e aprire Nuovo per il Test successivo:
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Sample Test 1  

Visualizzare la finestra di dialogo a schede contenente le Impostazioni  di  QGIS per la scelta delle “Opzioni”.
Impostare come Sistema di Riferimento (SR) di partenza per i nuovi progetti UTM 32N (WGS84 / UTM 32N –
EPSG: 32632). Copiare la vista così ottenuta nell’apposito spazio sottostante. 

Aprire QGIS, menù a tendina Impostazioni scelta Opzioni... :

Scegliere  Usa SR predefinito in SR per i Progetti di  Gestione del SR e con  Seleziona SR :
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In Filtro inserire la ricerca, ad esempio “utm 32 n”, verrà mostrato nelle opzioni di scelta il sistema richiesto: 

Soluzione

Immagine da copiare nella pagina del Test:
• l’immagine precedente 
• ovvero premendo OK la seguente:

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.
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Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 2  

Caricare  sull’interfaccia  dell’applicazione  QGIS  il  layer  in  formato  vettoriale  Province.shp,  presente  nella
directory C:\ECDL\dati. Portare la scala di visualizzazione al valore di 1:1.000.000. Copiare la vista così ottenuta
nell’apposito spazio sottostante.

Lanciare QGIS e se presente la Barra degli Strumenti per la Gestione dei Layer cliccare su  Apri Gestore delle
Sorgenti Dati 2, si apre la scheda Gestore delle sorgenti dati | Vettore, scegliere  Vettore ,  File e in Sorgente 
selezionare con  Sfoglia cercare lo shapefile Province nella cartella C:\ECDL\dati:

quindi cliccare su Aggiungi :

2 Altri modi per caricare un layer vettoriale è Barra dei Layer > Layer > Aggiungi Layer >  Aggiungi Layer Vettore… ovvero usare il
Pannello Browser

AMFM – Corso ECDL GIS – Modulo 3 - CC BY-NC-ND 3.0 IT – (2023) pag. 62



Viene visualizzato il Layer con scala determinata dall'area di visualizzazione della mappa corrente. Aprire nella Barra
di stato le opzioni sul box Scala e scegliere quella richiesta (1:1000000), oppure digitare nel box la scala richiesta: 

cliccare sul valore scelto, si ottiene la soluzione.

Soluzione
Immagine da copiare nella pagina del Test: 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.
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Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 3  

Caricare  sull’interfaccia  dell’applicazione  QGIS il  file  di  progetto  C:\ECDL\dati\Toscana_Windows.qgs,
accettare  la  conversione  dal  vecchio  formato,  attivare  la  visualizzazione  del  layer  vettoriale  idrografia.shp.
Eliminare dal pannello “Panoramica” (“Overview”) il layer  Parchi_nazionali.shp. Copiare la vista così ottenuta
nell’apposito spazio sottostante. 

Lanciare QGIS, menù Progetto, scegliere opzione  Apri:

cercare il progetto:

selezionare in Nome file Toscana_Windows.qgs e cliccare su Apri:
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se non attivo il Pannello Panoramica attivarlo con Visualizza > Pannelli > selezione Panoramica:
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risulta:

Nel quesito viene chiesto di attivare in visualizzazione mappa il layer Idrografia.shp ma risulta già attivato e di 
eliminare dal pannello Panoramica il layer Parchi_nazionali.shp ma risulta già eliminato 

Soluzione
L’immagine che si dovrebbe copiare nella pagina del Test è quella sopra visualizzata, ma la soluzione AICA risulta
molto differente come se fosse stato richiesto di:
• eliminare il pannello Panoramica
• rimuovere dal pannello Layer Parchi_nazionali
• disattivare dal pannello Layer la visualizzazione di Idrografia, Province e Toscana_100k

quindi se fossero state fatte queste richieste il risultato sarebbe stato:

immagine comunque differente dalla soluzione AICA per il fatto che nella soluzione AICA:
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• sarebbe dovuto essere presente nell’area di visualizzazione mappa il layer Toscana_100k
• la legenda del layer Srtm_90m è differente per alcune incompatibilità tra il sw QGIS della soluzione AICA e 

quello ora attivo.

Quindi è corretto comunque copiare nella pagina del Test:

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 4  

Caricare  sull’interfaccia  dell’applicazione  QGIS  il  layer  in  formato  vettoriale  Province.shp,  presente  nella
Directory C:\ECDL\dati.  Modificare le proprietà di visualizzazione del  layer assegnando colori  diversi  in base
nome della Provincia. Copiare la vista così ottenuta nell’apposito spazio sottostante.

Lanciare QGIS,  menu Layer > Aggiungi Layer >   Aggiungi Layer Vettore Province.shp, nel pannello  Layer
fare clic su Province e scegliere Proprietà :

Nella scheda  Proprietà Layer scegliere  Simbologia impostare nelle opzioni di scelta  Categorizzato e in  Valore il
campo PROVINCIA, quindi Classifica (Random colors) :

Premere OK, risulta:
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Questa visualizzazione è la risposta giusta da inserire come  printscreen… anche se nella soluzione AICA viene
visualizzata in Layer la legenda completa che si ottiene cliccando su ►.

Soluzione
L’immagine da copiare nella pagina del Test è quella sopra visualizzata.

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 5  

Caricare  sull’interfaccia  dell’applicazione  QGIS il  layer  in  formato  vettoriale  Province.shp,  presente  nella
Directory  C:\ECDL\dati  e  visualizzare  la  tabella  associata.  Copiare  la  vista  così  ottenuta  nell’apposito  spazio
sottostante

Lanciare QGIS, menu Layer > Aggiungi Layer >   Aggiungi Layer Vettore Province.shp,  nella  Barra degli
strumenti relativa agli Attributi cliccare su   Apri Tabella Attributi :

si ottiene la soluzione al Test:

… ma è diversa dalla soluzione AICA che rappresenta la tabella degli attributi di Strade_regionali  Da notare anche
che Province.shp rappresenta le province della Toscana come multipoligoni (isole e isole amministrative: 29 righe
invece di 10); da notare inoltre errori nei valori (negativi) di alcune aree 

Soluzione

La visualizzazione sopra riportata è la risposta giusta da inserire come printscreen…  nella pagina del Test.

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.
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Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 6  

Caricare il layer in formato vettoriale Strade_regionali.shp presente nella Directory C:\ECDL\dati esportare il file
salvandolo con il nome SR.shp nella cartella Risultati ed aggiungere una nuova colonna agli attributi (nome: valore
tipo:  integer)  calcolare  sulla  nuova  colonna  il  valore  di  80.  Mostrare  la  tabella  con  le  modifiche,  copiare
l’immagine con il risultato ottenuto nello spazio qui sotto 

Lanciare QGIS, menu Layer > Aggiungi Layer >  Aggiungi Layer Vettore Strade_regionali, nel menu Layer
fare clic su Salva con nome... :

In  Salva Vettore come… in  Formato lasciare  Formato ESRI shapefile,  in  Nome file inserire  SR.shp scegliendo
tramite tasto  la cartella Risultati, lasciare SR proposto e l’opzione Aggiungi il file salvato sulla mappa :

cliccare su OK e con layer SR selezionato nel pannello Layer fare clic su  Apri Calcolatore di Campi:
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Scegliere   Crea un nuovo campo,  in  Nome campo in uscita digita  valore,  in  Tipo campo in uscita scegliere
Numero intero (integer), nella scheda Espressione immettere 80 :

confermare con OK , salvare quanto fatto:
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Aprire la Tabella Attributi del layer SR:

Soluzione

L’immagine da copiare come  printscreen nella pagina del Test può essere la figura sopra riportata ovvero con lo
sfondo della GUI completa:

 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.
Da notare che nella cartella C:\ECDL\risultati è stato memorizzato lo shapefile SR
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Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 7  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale comuni.shp, presente nella Directory
C:\ECDL\dati. Creare un nuovo layer contenente tutti comuni della Provincia ‘MS’, salvarlo in C:\ECDL\risultati
con il nome di Comuni_MS.shp e caricarlo a video. Copiare la vista così ottenuta nell’apposito spazio sottostante

Lanciare QGIS,  menu Layer > Aggiungi Layer >   Aggiungi Layer Vettore comuni.shp e nella  Barra degli
Strumenti di Selezione fare clic su  Seleziona Elementi con Espressione... :

Nella scheda attivata comuni - Seleziona con Espressione costruire l'espressione di selezione impostando la selezione
in Campi e valori sul campo PROVINCIA e con apertura con clic dell'elenco in Tutti i Valori Univoci selezionare
MS e fare clic, risulta:

nel riquadro Espressione anteporre a ‘MS’ PROVINCIA = :
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fare clic su Seleziona Elementi, risulta:

Nel menù Layer scegliere Salva con nome... :

Compilare la scheda Salva Vettore come... come di seguito riportato:
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In Layer si è aggiunto Comuni_MS e nell'area di visualizzazione mappa i comuni della provincia selezionata sono
diversamente colorati:

Si potrebbe inserire come soluzione al Test il printscreen dell’immagine sopra riportata oppure si può inserire come
printscreen nella pagina del Test l’immagine che si ottiene disattivando comuni e facendo Zoom sui Layer, vedere
figura sotto riportata in Soluzione. 

Soluzione

Immagine da copiare con printscreen nella pagina del Test: 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.
Da notare che nella cartella C:\ECDL\risultati è stato memorizzato lo shapefile Comuni_MS
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Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 8  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato raster landsat_rgb, presenti nella Directory C:\
ECDL\dati. Cambiare il valore di trasparenza del layer in 50%   Copiare la vista così ottenuta nell’apposito spazio
sottostante. 

Lanciare QGIS, nella   Barra degli  Strumenti  per la Gestione delle Sorgeti  Dati fare clic su   Raster e
caricare landsat_rgb.tif :

facendo clic su landsat_rgb nel pannello Proprietà Layer - landsat_rgb scegliere Proprietà… > Trasparenza  :

impostare impostare Opacità Globale al 50% : 
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premere OK vedere il risultato nella figura sotto riportata in Soluzione. 

Soluzione

Immagine da copiare con printscreen nella pagina del Test. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 9  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale comuni.shp, presente Directory C:\
ECDL\dati.  Selezionare  il  comune  di  Cavriglia  (campo  NOMEMIN della  tabella  associata),  settare
opportunamente l'unità di misura della mappa e, mediante il comando “Linea di misura”, calcolare la lunghezza del
perimetro del poligono selezionato. Copiare la vista così ottenuta nell’apposito spazio sottostante.

Aprire QGIS, caricare il layer vettoriale comuni.shp, menù Layer scegliere opzione Filtro... :

e nel Costruttore di interrogazioni costruire l'espressione “NOMEMIN” =  ‘Cavriglia’ :

risulta:
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fare  Zoom completo :

Attivare l'opzione  Misura linea e ripercorrere la digitalizzazione di massima del contorno. Si ottiene il risultato : 
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Soluzione

L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 10  

Caricare  sull’interfaccia  dell’applicazione  QGIS il  layer  in  formato  raster  Toscana_100k.tif,  presente  nella
Directory C:\ECDL\dati. Nel caso necessitasse, impostare correttamente unità di misura e sistema di proiezione del
progetto e calcolare la distanza che separa la città di Piombino (X= 1625301, Y=4754000) e il paese di Cavo (Isola
d’Elba) (X=1615835,  Y=4746358). Copiare l’immagine con i  risultati  ottenuti  nell’apposito foglio del file  C:\
ECDL\risultati_cognome\risposte_cognome.rtf

Lanciare QGIS, caricare il layer raster richiesto e invio; in Layer e nell'area di visualizzazione mappa risulta caricato
il layer Toscana_100k :

Verificare unità di misura e ellissoide per il calcolo delle distanze aprendo Proprietà... del Progetto:

NOTA: il quesito indica coordinate della città di Piombino (X= 1625301, Y=4754000) e del paese di Cavo (Isola d’Elba) (X=1615835,
Y=4746358) ma in realtà tali coordinate sono indicative per posizionarsi nello zoom nei pressi di tali comuni, infatti nella soluzione AICA è
indicata la distanza di 11.918,250 metri e non di 12.168,434 metri che risulterebbe con un calcolo eseguito con procedimenti più articolati e
complessi e riferito a tali coordinate.
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Zoomare su zona del canale di Piombino, individuare Piombino e Cavo:

attivare Misura linea tasto  , posizionarsi su Cavo e clic sinistro, poi spostarsi su Piombino e di nuovo clic sinistro
quindi clic destro per chiudere la misurazione, risulta:

Soluzione
L’immagine da copiare come printsreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Da notare che si può anche cambiare da distanza ellissoidica a distanza cartesiano (euclidea) che risulta minore
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Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS

Nota: nella soluzione del Test AICA la distanza (sempre approssimata) è di 11.918,250 metri
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Sample Test 11  

Caricare  il  layer  in  formato  vettoriale  bacini.shp presente  nella  Directory  C:\ECDL\dati.  Utilizzare  il  plugin
“fTools” (Menu “Vettore”). Eseguire l’operazione “Join attributes” tra la tabella  tipo_bacini del file  C:\ECDL\
join_bacini.csv e lo shapefile  bacini.shp, collegando il campo “tipo” del file .csv (che contiene le tipologie di
bacino) con il corrispettivo del campo BACINO della tabella associata al vettore bacini.shp. Creare in tal modo il
nuovo strato vettoriale bacini_join.shp (con l’opzione “Includi tutti i record”) e salvarlo nella Directory C:\ECDL\
risultati. Mostrare la tabella del nuovo vettore con il join eseguito, Copiare la vista così ottenuta nell’apposito
spazio sottostante.

Nota preliminare: nelle versioni QGIS da molti  anni non esiste più in il  plugin “fTools” (Menu “Vettore”), le  sue funzionalità sono
comprese nell’applicazione stessa.

Caricare il layer vettoriale bacini.shp e la tabella join_bacini.csv, aprire la tabella degli attributi di bacini.shp e la
tabella join_bacini.csv, si evidenzia quanto richiesto dal quesito è cioè che il campo  “BACINO” di bacini.shp può
essere collegato con il campo “tipo” del file join_bacini.csv.

NOTA IMPORTANTE:  fatto salvo però che i primi due poligoni delle figura qui sotto riportata del layer bacini hanno codifiche in BACINO non presenti
in tipo di join_bacini:

e quindi nel join non agganceranno informazioni da join_bacini. Da notare anche che join_bacini ha 12 righe di cui 2 con stesso codice tipo = 10 e una con
codice tipo =09, quest’ultima non si aggancia con BACINI
Si potrebbero evidenziare i valori univoci di BACINO nel layer bacini applicando la funzione Elenco dei valori univoci in Analisi sui vettori di Strumenti
di Processing:
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risulterebbero 12 valori univoci:

Riprendendo quindi da: 

“Caricare il layer vettoriale bacini.shp e la tabella join_bacini.csv, aprire la tabella degli attributi di bacini.shp e la  tabella join_bacini.csv, si
evidenzia  quanto  richiesto  dal  quesito  è  cioè  che  il  campo  “BACINO”  di  bacini.shp  può  essere  collegato  con  il  campo “tipo”  del  file
join_bacini.csv.”

per effettuare il collegamento cliccare su bacini, scegliere Proprietà… e selezionare opzione  Join:
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si apre la scheda con le opzioni per la gestione dei collegamenti, con clic su  si apre la scheda della definizione del
collegamento tra il layer nel quale si è posizionati (bacini) e il layer disponibile per il join (join_bacini) con una
ipotesi casuale di scelta nel Campo unione di join_bacini (nel caso specifico tipo che va bene) e una scelta casuale del
Campo destinazione di bacini (nel caso specifico cat che non va bene):

quindi facciamo la scelta corretta:
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facendo clic su OK si ha la definizione del join da salvare, nel layer bacini si ha una nuova tabella degli attributi in
definizione temporanea (vettore unito in memoria virtuale) con l’aggiunta dei campi provenienti dal join:

Per creare il nuovo layer con il nome richiesto e salvarlo nella cartella C:\ECDL\risultati attiviamo su bacini Esporta
> Salva Elementi Come…:
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premendo OK e aprendo la Tabella Attributi del nuovo layer si ha la soluzione al Test:

soluzione che può essere mostrata anche posizionandosi sulla mappa con  e cliccando su un bacino: 

AMFM – Corso ECDL GIS – Modulo 3 - CC BY-NC-ND 3.0 IT – (2023) pag. 93



Soluzione
L’immagine da copiare come printsreen nella pagina del Test è una delle due sopra riportate. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 12  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale comuni.shp, presente nella Directory
C:\ECDL\dati. Identificare il comune di Firenze mostrandone gli attributi correlati. Copiare la vista così ottenuta
nell’apposito spazio sottostante. 

Lanciare QGIS, caricare il layer comuni.shp scegliere  Seleziona Elementi Usando un'Espressione:

nella scheda Seleziona con Espressione in Campi e valori scegliere e cliccare su NOMEMAI, cliccare o immettere = ,
in Valori cliccare su Tutti i Valori Univoci, quindi trovare e cliccare su FIRENZE, risulta: 

cliccare su  Zoom agli  Elementi,  al  centro dell’area di  visualizzazione mappa risulta  il  poligono dei  confini  del
comune di Firenze, posizionando su di esso  Informazioni Elementi risulta:
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Soluzione

L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 13  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale  bacini.shp, presente Directory C:\
ECDL\dati.  Partendo dalla tabella degli attributi,  effettuare una query identificando il  record relativo al bacino
dell'Arno (campo  DESCR),  selezionare  il  record effettuare  uno zoom ai  poligoni  identificati  (tramite  il  tasto
“Zoom mappa alle righe selezionate”). Copiare la vista così ottenuta nell’apposito spazio sottostante. 

Lanciare  QGIS caricare  il  vettoriale  bacini.shp,  cliccare  su   Apri  Tabella Attributi,  scegliere   Seleziona
elementi usando un'espressione:

fare clic e costruire l'espressione “DESCR”= “Arno”:

cliccare su  Seleziona Elementi, si ottiene:
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Soluzione

L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 14  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale parchi_nazionali.shp, presente nella
Directory C:\ECDL\dati. Selezionare i valori presenti nel campo NOME uguali a “ARCIPELAGO TOSCANO”.
Creare un nuovo layer con i soli elementi selezionati con il nome arcipelago_toscano.shp, salvarlo nella Directory
C:\ECDL\risultati  e visualizzarlo sul display. Creare un nuovo campo nella Tabella degli attributi,  denominarlo
“ETTARI” (Decimal number, real); quindi, calcolare nel nuovo campo la superficie in ettari, dividendo per 10.000 i
valori presenti nel campo “AREA”. Copiare l’immagine con il risultato ottenuto nell’apposito spazio sottostante. 

Lanciare  QGIS,  caricare  il  layer  vettoriale  parchi_nazionali.shp,  scegliere   Seleziona  elementi  usando
un'espressione, costruire l'espressione   “NOME”= “ARCIPELAGO TOSCANO”:

cliccare su  Seleziona Elementi, quindi nel pannello Layer clic su Parchi nazionali e scegliere Esporta > Salva
Elementi Selezionati Come...
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si apre la scheda  Salva Vettore come... dove definiamo di salvare nella cartella  risultati con il nome richiesto il
risultato di Salva solo gli elementi selezionati:

premendo OK risulta

apriamo  Tabella Attributi in modifica  con aggiunta di Nuovo campo:

AMFM – Corso ECDL GIS – Modulo 3 - CC BY-NC-ND 3.0 IT – (2023) pag. 100



definiamo il campo come richiesto:

impostare ETTARI = AREA/10000 poi Aggiorna Tutto, risultato da salvare chiudendo lo stato di modifica  :

Soluzione
L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.
Da notare che nella cartella C:\ECDL\risultati è stato memorizzato lo shapefile arcipelago_toscano
(da notare anche che le aree sono complessive dei multipoligoni in “TIPO”)

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 15  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale strade_regionali.shp, presente nella
Directory  C:\ECDL\dati.  Utilizzando  gli  strumenti  di  Geoprocessing  creare  un  buffer di  500 metri  (con
dissolvenza)  salvando  il  layer  in  formato  shapefile  nella  Directory  C:\ECDL\risultati  con  il  nome
strade_buffer.shp. Copiare l’immagine del layer con il risultato ottenuto nell’apposito foglio del file  C:\ECDL\
risultati_cognome\risposte_cognome.rtf 

Lanciare QGIS, menù a tendina Layer> Aggiungi Layer > Aggiungi LayerVettore... Strade_regionali.shp, menù a
tendina Vettore scegliere Strumenti di Geoprocessing e opzione Buffer :

Impostare il buffer richiesto in Distanza, in Dissolvi il risultato e scegli il resto come di seguito mostrato:

si genera un layer temporaneo Risultato da operazione di buffer   :
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Per salvare il file Risultato da operazione di buffer scegliendo Esporta attivare Salva Elementi Come… :

Nella scheda che si apre salvare con il nome richiesto strade_buffer nella cartella C:\ECDL\Risultati :
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risulta:

Soluzione
L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.
Da notare che nella cartella C:\ECDL\risultati è stato memorizzato lo shapefile strade_buffer
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Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 16  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale comuni.shp, presente nella Directory
C:\ECDL\dati.  Classificare  i  dati  contenuti  nel  campo  AREA della  tabella  attributi  del  layer,  con  il  metodo
“Intervalli uguale” (“Equal interval”) in “5 Classi”. Copiare la vista così ottenuta nell’apposito spazio sottostante. 

Lanciare QGIS, caricare il layer vettoriale comuni.shp e attivare Proprietà… :

nella scheda Simbologia scegliere Graduato sul Valore AREA con Classi 5, Intervallo Uguale, Classifica e OK:

risulta:
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Soluzione
L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 17  

Caricare  sull’interfaccia  dell’applicazione  QGIS  il  layer  in  formato  vettoriale  province.shp,  presente  nella
Directory C:\ECDL\dati. Rappresentare le province con un poligono senza riempimento ed un contorno tratteggiato
rosso con spessore pari a 2 mm. Copiare la vista così ottenuta nell’apposito spazio sottostante. 

Lanciare QGIS, menu Layer > Aggiungi Layer >  Aggiungi Vettore Province.shp, nel pannello Layer fare clic su
Province e scegliere Proprietà... :

Nella scheda Proprietà Layer scegliere Simbologia impostare nelle opzioni di scelta Simbolo singolo, Riempimento
semplice,  Colore di  riempimento in  Riempimento Trasparente,  Colore tratto in  Rosso,  Spessore tratto in  2
millimetri, Stile tratto in Linea tratteggiata e premere OK :

Risulta: 
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Soluzione
L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 18  

Caricare  sull’interfaccia  dell’applicazione  QGIS  il  layer  in  formato  vettoriale  province.shp,  presente  nella
Directory C:\ECDL\dati.  Modificare le proprietà di  visualizzazione del  layer assegnando ad ogni  provincia un
colore diverso usando una ColoRamp Br-Blu. Copiare la vista così ottenuta nell’apposito spazio sottostante. 

Lanciare QGIS, caricare Province.shp, attivare Proprietà... scegliere Categorizzato in scheda Simbologia, in Valore
scegliere  PROVINCIA,  in  Scala colore scegliere in  Tutte  le Scale  Colore la  scala  che più si  avvicina a  quella
proposta dal Sample Test, ad esempio BrBG, quindi Classifica e poi OK:

Risulta:
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Soluzione
L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS
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Sample Test 19  

Caricare  sull’interfaccia dell’applicazione QGIS il  progetto  Toscana_Windows.qgs,  presente  nella cartella  C:\
ECDL\dati. Attivare lo strato Parchi_nazionali e fare uno zoom sulla parco nazionale dell'Arcipelago Toscano.
Entrare in ambiente “Composizione di stampa”, impostare la dimensione della mappa come  Personalizzata con
dimensioni 200X200 mm scala d 1:1.000.000 ed aggiungere la Mappa visualizzata nel progetto. Copiare la vista
così ottenuta nell’apposito spazio sottostante. 

Caricare  il  Progetto  Toscana_Windows.qgs presente  in  C:\ECDL\dati,  non  è  necessario  attivare  il  layer
Parchi_nazionali in quanto risulta essere già attivo, selezionarlo sul  pannello Layer e scegliere nella  Barra degli
Strumenti di Selezione l’opzione Seleziona Elementi con Espressione… : 

per effettuare la selezione richiesta compilare la scheda che si apre nel modo seguente:

cliccare su Zoom agli Elementi, risulta: 
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nella Barra dei Menu scegliere Progetto > Nuovo Layout di Stampa…: 

facendo clic si apre l’opzione per dare un nome al layout, lasceremo vuoto:

cliccando su OK si apre la GUI (Graphic User Interface) per la gestione dei Layout con diversa Barra dei Menu e
diverse Barre degli Strumenti: 
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posizionandosi sull’area di visualizzazione del layout fare clic e scegliere Proprietà pagina… :

risultano le seguenti proprietà dell’oggetto:
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per  rispondere  al  Test  bisogna modificare  la  Dimensione in  Personalizzato e  Larghezza  e Altezza in  200 mm,
cliccare su Zoom Completo, risulta:

quindi cliccare su Aggiungi Mappa :
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tenendo premuto il tasto sinistro del mouse spostarsi nell’area di visualizzazione del layout e disegnare un rettangolo
per creare l’area in cui sarà visualizzata la mappa attualmente attiva nell’area mappa del progetto: 

risulta:
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modificare la scala come richiesto a 1000000:

NOTA per togliere la cornice di inquadramento cliccare due volte sul flag vicino a Mappa1in Oggetti.

Soluzione
L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.

AMFM – Corso ECDL GIS – Modulo 3 - CC BY-NC-ND 3.0 IT – (2023) pag. 117



Confronto con soluzione AICA

NOTA: la soluzione AICA non è corretta, non risponde adeguatamente al Test !
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Sample Test 20  

Caricare  sull’interfaccia  dell’applicazione QGIS il  progetto  Toscana_Windows.qgs,  presente  nella  cartella  C:\
ECDL\dati. Preparare un layout di stampa con dimensione A4 (Direzione: Verticale), visualizzando tutta la regione
ed inserendo un titolo e la barra di scala con queste caratteristiche: 4 segmenti di 25 Km. 
Copiare la vista così ottenuta nell’apposito spazio sottostante.

Caricare il Progetto Toscana_Windows.qgs :

Attivare da Progetto →  Nuovo Layout di Stampa...  :

oppure dalla Barra del Progetto pulsante  Nuovo Layout di Stampa :
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fare clic sull'area di visualizzazione della pagina di stampa si attiva un menu su cui selezionare  Proprietà pagina,
impostare il formato richiesto :

Cliccare su  Aggiungi Mappa al layout e con il tasto sinistro del mouse premuto tracciare un rettangolo in cui 
visualizzare la mappa :
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Tasto   Aggiungi  Etichetta al  layout,  con  il  tasto  destro  del  mouse  premuto  tracciare  il  rettangolo  in  cui
visualizzare  la  scritta,  viene  visualizzato  un  box e  un  testo  predefinito  in  Etichetta,  sovrascrivere  ECDL,  nella
opzione  Aspetto scegliere  Carattere ingrandire il  carattere -  ad esempio a Dimensione carattere  (punti)  25 -  e
centrare con  Centro e Al centro Allineamento orizzontale e Allineamento verticale :

Tasto  Aggiungi Barra di Scala al layout e modificare come richiesto 4 segmenti di 25 km e centrare :

Soluzione
L’immagine da copiare come printscreen nella pagina del Test è quella sopra riportata. 

Non salvare il Progetto.
Salvare il file test_cognome_nome.rtf.
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Confronto con soluzione AICA
Soluzione presente in GRIGLIA_TestM3_QGIS_SampleTest.XLS

NOTA: la soluzione AICA non è del tutto corretta in quanto alcuni layer risultano disattivati ma non era stato
richiesto !
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Altri esercizi

Altro Esempio A  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale comuni.shp, presente nella Directory
C:\ECDL\dati. Creare un layer temporaneo con il raggruppamento delle geometrie multiparte, creare in tale layer il
campo virtuale  den91kmq con la formula  POP1991 / ($area/1000000). Classificare i dati contenuti nel campo
den91kmq della tabella attributi del layer, con il metodo “Colore continuo” con una rampa di colori a piacere.
Copiare la vista così ottenuta nell’apposito spazio sottostante. 

Dopo aver caricato il layer comuni.shp si nota aprendo al Tabella Attributi (Elementi Totali 313)  che per alcuni deo
287 comuni esistono più poligoni (isole amministrative e/ isole fisiche) con area di pertinenza riferita al singolo
poligono ma con popolazione uguale, evidentemente definita sull’intero comune. Vedere ad esempio qui sotto uno
stralcio della Tabella Attributi:

attivare la funzione  Riassembla geometrie… che trasforma lo shapefile da geometrie singole a multi geometrie
operando sul campo NOMEMAI:
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con Esegui viene generato un layer temporaneo di nome Raggruppato:

il layer Raggruppato ha 287 poligoni e solo i campi che per i quali nella tabella originaria i contenuti riferiti alle
diverse  geometrie  di  un  comune  erano  identici  (come  NOMEMAI,  NOMEMIN,  ….  POP51,  POP61,  POP71,
POP81,POP91, ……) hanno senso, per gli altri campi i valori sono scorretti in quanto viene selezionato il primo
valore intercettato nel  raggruppamento di  ogni  comune;  vedere  ad esempio qui  sotto  nello  stralcio della  Tabella
Attributi i comuni di ISOLA DEL GIGLIO e di MONTE ARGENTARIO confrontati con stralcio precedente:

Definire ora un nuovo campo virtuale nel layer temporaneo Raggruppato con il Nome campo in uscita den91kmq
calcolando contemporaneamente il valore di densità della popolazione riferita ai chilometri quadrati.
Aprire il Calcolatore di Campi e definire la scheda come segue:
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cliccare su OK, per vedere meglio il risultato organizziamo l’ordine di visualizzazione della posizione dei campi 

e rendere temporaneamente visibili solo i campi come selezionati di seguito:

risulta:

cliccare su  per salvare il risultato.  
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Ora si dovrebbero classificare i dati contenuti nel campo den91kmq della tabella attributi del layer, con il metodo
“Colore continuo” con una rampa di colori a piacere ma tale metodo di classificazione non esiste più da anni nelle
versioni di QGIS quindi si potrà realizzare una visualizzazione simile con :

Raggruppato > Proprietà… > Simbologia > Graduato > Valore = den91kmq 

scegliendo un opportunamente elevato numero di  Classi  e una opportuna  Modalità per evidenziare le differenze
nella  Scala colore scelta. In genere si dovrà scegliere un  numero di classi elevato e come modalità o quella per
Conteggio uguale o quella per Intervalli Naturali. Nel caso specifico si effettuano le seguenti scelte:

risultato (si è evidenziato nel pannello Layer il numero di comuni per ciascuna classe):

Soluzione
Copiare l’immagine sopra riportata come printscreen  da salvare nell’apposito spazio sottostante al Test.
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Altro Esempio B  

Caricare sull’interfaccia dell’applicazione QGIS il layer in raster  Toscana_100k.tif, presente nella Directory C:\
ECDL\dati.   Individuare  l’Isola  di  Gorgona  spostandosi  su un  punto  (ad  esempio  X Y = 1572200 4808500).
Effettuare  uno  zoom  sull'Isola.   In  C:\ECDL\risultati  creare  un  nuovo  layer  vettoriale  shapefile
Batimetrica100_Gorgona.shp digitalizzando la batimetrica 100 intorno all'isola. 
Applicare al nuovo layer la trasparenza al 50% 

Caricare il layer raster Toscana_100.tif , ad esempio come di seguito mostrato:

quindi clic su Aggiungi, poi controllare sia attiva la Barra degli Strumenti di Digitalizzazione :
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andare nel box del localizzatore  (in basso a sinistra nella Barra di Stato) e immettere
le coordinate 1572200 4808500 :

dando INVIO si attiva un pallino rosso lampeggiante sulla mappa su tali coordinate e il raster nell’area mappa viene
centrato su tali coordinate, quindi far zoom con rettangolo sul punto con Ingrandisci, risulta:
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Creare layer vettoriale poligonale: Layer > Crea vettore > Nuovo Shapefile…:

Definire la scheda che si apre come di seguito mostrato:
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Si genera il poligono vuoto Batimetrica100_Gorgona; posizionarsi su tale vettore nel pannello Layer e nella Barra
degli Strumenti di Digitalizzazione cliccare su   Attiva Modifiche quindi cliccare su   Aggiungi Elemento
Poligonale :

Posizionarsi su un punto della Batimetrica100_Gorgona fare primo clic sinistro, muoversi a contornare e di nuovo
click sinistro, ripetere con click sinistri a percorrere il contorno

terminare la digitalizzazione con clic destro, si apre il pannello Attributi elemento che si può lasciare vuoto: 
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con OK risulta:

chiudere lo stato di modifica cliccando su  , viene chiesto di salvare, scegliere Salva :
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Nel pannello Layer attivare le Proprietà Layer  - Simbologia  su Batimetrica100_Gorgona e nella visualizzazione a
Simbolo singolo attivare Opacità al 50%:

risulta:
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Soluzione

Copiare l’immagine sopra riportata come printscreen  da salvare nell’apposito spazio sottostante al Test.
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Altro Esempio C  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale  riserve_valdinievole.shp, presente
nella Directory C:\ECDL\dati. Applicare etichette sul campo  b_nome con contorno, con caratteri in grassetto di
colore rosso su sfondo verde, con posizionamento Offset da centroide quadrante in basso a sinistra, visualizzare sul
display.

Lanciare QGIS, menu Layer > Aggiungi Layer >  Aggiungi Vettore riserve_valdinievole.shp :

Caricato il layer attivare le etichette cliccando su Opzione per le Etichette del layer :

scelta   Etichette singole, nella scheda   Testo definire il  Valore da evidenziare (b_NOME), Carattere, Stile,
Dimensione, Colore (Rosso) e Opacità:
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nella scheda   Buffer effettuare le seguenti scelte per definire un contorno:

nella scheda  Posizionamento  scegliere  Offset dal Centroide e Quadrante in basso a sinistra:
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risultato:

Soluzione

Copiare l’immagine sopra riportata come printscreen  da salvare nell’apposito spazio sottostante al Test.
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Altro Esempio D  

Caricare sull’interfaccia dell’applicazione QGIS il layer in formato vettoriale comuni.shp, presente nella Directory
C:\ECDL\dati.  Creare un nuovo shape con i  soli  comuni confinanti con il comune di FIRENZE in  C:\ECDL\
risultati con il nome Comuni confinanti Firenze.

Lanciare QGIS caricare il layer vettore comuni.shp scegliere  Seleziona Elementi con Espressione…:

In Campi e valori selezionare NOMEMAI (o NOMEMIN) e selezionare = ‘FIRENZE’ :

cliccare su  Seleziona Elementi, in visualizzazione mappa risulta:
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salvare il risultato come nuovo layer con comuni > Esporta > Salva Elementi Come…:

si apre la scheda Salva Vettore come..., compilare la scheda come segue:
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cliccando su OK risulta:

cliccare su  Seleziona per posizione e compilare la scheda come segue:
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risulta:

salvare il risultato come nuovo layer con comuni > Esporta > Salva Elementi Come…:
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creare il nuovo shape con il nome Comuni confinanti Firenze nella cartella C:\ECDL\risultati:

si aggiunge il nuovo layer:
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visualizzando la Tabella Attributi si evidenziano i 6 comuni confinanti con FIRENZE:

Soluzione

Copiare l’immagine sopra riportata come prinscreen da salvare nell’apposito spazio sottostante al Test.
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compilare la scheda Salva Layer Temporaneo come segue:

si ha la soluzione shapefile Comuni confinanti Firenze salvato nella cartella C:\ECDL\risultati.
Eventualmente salvare  nel  documento  C:\ECDL\test_cognome_nome.rtf  l’immagine  seguente  ottenuta  con  la
rimozione di tutti i layer e il successivo caricamento del nuovo shapefile, volendo arricchito della visualizzazione
della tabella attributi dove compaioni i nomi dei 6 comuni confinanti con FIRENZE:
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